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S E C T I O N  1  

Intergraph® SmartPlant License Manager allows you to accurately track how many users are 
concurrently accessing plant design software. It also helps you comply with your Software 
Licensing Agreement. 
SmartPlant License Manager (SPLM) is client/licensing machine-based software. One or more 
central licensing machines can be used to maintain licensing information for all plant design 
software on a network. The licensing information can be on a single licensing machine, but the 
licenses float so any computer on the network can use them. Both the client computer and the 
licensing computer must have SmartPlant License Manager installed. Because licensing has 
little impact on computer performance, any computer can be a license machine.  However, 
systems with a high volume of network traffic may negatively impact licensing performance. 
SmartPlant License Manager supports the following products and license types: 
 CAESAR II 
 CADWork 
 FrameWorks® Plus 
 ISOGEN™ (Batch ISOGEN and Interactive ISOGEN) 
 PDS®: PDS 3D, PDS 2D, PDS IDM, PDS 2D PID 
 PV Elite 
 PV Fabricator 
 SDNF Import 
 Smart 3D to PDMS Exporter 
 SmartMarine™ 3D 
 SmartMarine 3D Hull 
 SmartMarine 3D Layout 
 SmartMarine 3D Outfitting 
 SmartMarine 3D Tribon 
 SmartPlant Construction 
 SmartPlant® Electrical Basic (formally SmartPlant Electrical) 
 SmartPlant Electrical Detailed Engineering (formally sigraph.CAE) 
 SmartPlant Instrumentation (formerly INtools®) 
 SmartPlant Isometrics (formerly I-Sketch) 
 SmartPlant Materials 
 SmartPlant Materials Material Life Cycle Library 
 SmartPlant Materials Engineering and Procurement Integration Module 
 SmartPlant Materials Material Supply Chain Management Module 
 SmartPlant Materials Site Management Module 
 SmartPlant Materials Integrator Module 
 SmartPlant Materials Supplier Module 
 SmartPlant P&ID 
 SmartPlant P&ID Design Validation Tool 
 SmartPlant P&ID Engineering 
 SmartPlant Plant Engineering Solution Bundle 

Introduction 
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 SmartPlant 3D 
 SmartPlant 3D Bundle (Support bundle licensing in SmartPlant 3D, SmartMarine 3D, and 

SmartPlant 3D Materials Handling Edition) 
 SmartPlant 3D Import commands 
 SmartPlant 3D Materials Handling Edition 
 SmartPlant Layout 
 SmartPlant Reference Data 
 SmartPlant Review 
 SmartPlant Review Publisher 
 SmartPlant Spoolgen® (formerly SPOOLGEN) 
 SmartSketch® 
 SmartSketch Drawing Editor 
 SupportModeler™ for PDS 
 SupportManager™ for PDS 
 TANK 

 
 For detailed information about using SmartPlant License Manager with SmartPlant 

Materials, refer to the SmartPlant Materials and SmartPlant Reference Data License 
Handling document. 

 Interference checking commands will use a license each time an interference detection 
service is processed. 

 Some SmartSketch installations do not require licensing.  Ask your system administrator or 
contact Intergraph Support Services if you have a question about SmartSketch licensing 
requirements. 

 This guide includes information and request forms for both SmartPlant Instrumentation 
versions 7 and higher, which use SmartPlant License Manager, and the earlier versions 6 
and lower, which were known as INtools and used their own internal licensing software. 
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 Refer to the General Topics FAQ (on page 76) for answers to licensing setup and 
configuration questions. 

 
Intergraph software is purchased or leased by the license. For example, if you purchased 30 
licenses, you are licensed for 30 processes to concurrently access the various software 
applications. SmartPlant License Manager keeps a running inventory of how many licenses are 
in use and how many are available for use. 
When an application is started, the application sends a request to one or more SmartPlant 
License Manager license machines to obtain a license to run the software. If a license of the 
requested type is available, SmartPlant License Manager grants the license and the application 
starts. If all licenses of the requested type are in use when you begin an interactive session, the 
software does not start. If all licenses are in use when a batch job requests a license, the batch 
job waits until a license is released when a user logs out or another batch job completes. 
SmartPlant License Manager requires users to have administrator privileges to change the 
license usage options (Display and Modify License Usage). 
The Print option on the SmartPlant License Manager Information dialog box saves displayed 
output to a file and/or prints the output to a selected printer. 

SmartPlant Enterprise Product Compatibility Matrix 
Additional information about integrated authoring tools and the databases they support is 
available in the SmartPlant Enterprise Product Compatibility Matrix on the Intergraph Process, 
Power & Marine eCustomer Web site. To view this matrix, browse to the following Web address, 
and type your eCustomer user name and password: 
https://crmweb.intergraph.com/ecustomer_enu.  Click Download Software Updates > 
Products, and then click the PPM Compatibility Matrices link. 
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See Also 
License Key Request Forms (on page 87) 
Quick Installation Workflow (on page 21) 
Installation Checklist (on page 22) 
Upgrades and License Keys (on page 15) 
SmartPlant License Manager Functions (see "Functions of SmartPlant License Manager: 
License Machine" on page 33) 
General Topics FAQ (on page 76) 
 

What's New in SmartPlant License Manager 
The following changes have been made to SmartPlant License Manager. 
Version 2012 
 SmartPlant License Manager now supports and includes the following product tags. 

 CADWorx 
 CAESAR II 
 PV Elite 
 PV Fabricator 
 Smart 3D to PDMS Exporter 
 SmartPlant 3D Bundle (Support bundle licensing in SP3D, SM3D and SmartPlant3D 

Materials Handling Edition) 
 SmartPlant Construction 
 SmartPlant Electrical Detailed Engineering (formally sigraph.CAE) 
 SmartPlant P&ID Engineering 
 SmartPlant Plant Engineering Solution Bundle (support bundle licensing in SPPID, SPI , 

SPEL Basic and SPEL Detailed) 
 SmartPlant3D Materials Handling Edition       
 Tank 

 Smart 3D Bundle (Support bundle licensing in SP3D, SM3D and SmartPlant3D Materials 
Handling Edition) 

 SmartPlant License Manager now supports a new counted type seat for the license key. 
 SmartPlant License Manager now supports Microsoft Windows 7 and Microsoft Windows 

Server 2008 R2 
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Internationalization 
Supporting internationalization in a homogeneous environment is one of the enhancements 
available in SmartPlant Enterprise. A homogeneous environment uses elements from only a 
single locale. For example, a German customer running on a German operating system using 
only German characters and German cultural conventions is a fully supported homogeneous 
environment configuration. 

Homogeneous Environments 
When starting a new project, use extra care during installation and configuration to ensure the 
proper creation and maintenance of homogeneous environments: 
 All the computers (servers and clients) within an integrated SmartPlant Enterprise 

implementation must have the same regional settings, and no one should change the 
regional settings after the project has started. 

 Do not cross the decimal locale boundary. This is the most common cause of numeric data 
corruption and calculation errors. Having users with different regional settings (like with a 
period versus a comma for the decimal point) causes the software to interpret values 
unpredictably. For example, a pipe run with a pressure of 35.3 psi can be read by the 
software as 353 psi to the user with different regional settings. A cable length defined as 39 
ft 11,21 inches has been interpreted as 121718910971323 meters when published to an 
XML file. These incorrect interpretations may be used in internal software calculations and 
can be impossible to backtrack or correct. Do not change the decimal point character to try 
to solve an issue. Doing so will only corrupt values in the database or in text files. 

 Do not cross the character-set locale boundary. For example, the character set boundary 
between Western (Latin-based) and Eastern Europe (Cyrillic-based), or between Eastern 
Europe and Japan. 

 Create Oracle databases using AL32UTF8 for the database character set and AL16UTF16 
for the NLS character set. 

 Never modify the NLS_LANG registry entry on an Oracle client. Doing so causes the 
character data not to convert to Unicode. 

 Create Microsoft SQL Server databases with locale-specific collation settings and ensure 
that all databases have the same setting. 

Heterogeneous Environments 
In contrast, a heterogeneous environment using elements from different, or even multiple 
locales, is not supported. Many customers are currently operating in unsupported 
heterogeneous environments and are often not aware of that fact. Examples of heterogeneous 
environments: 
 Entering or viewing Japanese data on an US/English operating system 
 Using German Regional Settings (where the decimal point is a comma) on a US/English 

operating system 
 Using databases with different character encodings such as CL8MSWIN1251 or JA16SJIS 
 Using multiple languages in a project, especially when crossing language-group boundaries 
 Using an English server with different local language clients 

International / Bi-lingual Projects 
International bi-lingual projects are possible; however, great care must be used when 
configuring these environments. Limitations exist and must be properly understood: 
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 Oracle and MS SQL Server databases can reside on any language operating system, as 
long as the databases have been created and configured with proper Unicode and collation 
settings. 

 All Microsoft operating systems (Japanese, Russian, German, and so forth) can enter 
English characters. The reverse, however, is not true in most cases. 

 Keyboard-locale can be changed as long as a character-set and code-page boundary is not 
crossed. For example, English, German, French, and Spanish characters can all be used in 
the same project because the same Windows® code-page (1252) is used. However, Russian 
characters (code-page 1251) cannot be used in a US/English environment. 

 You must decide which language operating system will be the master for bi- lingual projects. 
The following is an example of a Russian-based project: 
Companies in the United States and the United Kingdom are working a project with a Russian 
company and the deliverables (drawings, reports, and so forth) must ultimately be provided in 
Russian. The companies in the U.S. and the U.K. are working the project using the "master" 
Russian operating systems (possibly using virtual Russian operating systems running on 
VMware Workstation). The U.S. and U.K. companies can install and use English Microsoft 
Office products on the Russian operating system because Office products are globally enabled. 
If a Russian interface exists for the SmartPlant Enterprise application, then Russian users can 
use the Russian interface while the English-speaking users would continue to use the 
US/English interface. English-speaking engineers can enter English characters. 
Russian-speaking engineers can enter Russian characters. 
However, because the Russian locale uses different decimal and character-set locales, 
everyone (English and Russian engineers) must use the Russian decimal symbol which is a 
comma. For customization purposes, databases can be modified to accommodate new 
Russian-specific requirements (fields, properties, and so forth.) Using filters, display sets, and 
other software features, bi-lingual projects can be further customized. Graphic data, reports, and 
so forth can be created in either or both languages. 

 Do not change regional settings to reflect a U.S. environment in order to resolve 
problems in a non-US/English homogeneous configuration. Doing this creates a heterogeneous 
configuration that will cause other possibly hidden problems that cannot be corrected. Everyone 
working on a project must use the same regional settings and character set throughout the life of 
the project. 

Questions and Assistance 
Please contact your support representative for assistance and answers to your questions: 
Intergraph Customer Support (http://support.intergraph.com (http://support.intergraph.com)). 
 

Terms 
License Key – An alphanumeric code entered on a licensing machine that activates a license. 
The encrypted code tells the licensing machine how many licenses and type(s) that have been 
leased or purchased and, therefore, how many it can issue. A key can be from 256 to 264 
characters long. 
License – A contractual right to run a copy of the software. A license key activates a license. 
Remote License Mode / Checkout – Running SmartPlant Review and SmartSketch without a 
network connection to the license machine. You must install and run the SmartPlant License 
Checkout Utility to use this mode. For more information, refer to Appendix A of this document or 
refer to the SmartPlant License Checkout Utility User’s Guide delivered with SmartPlant Review 
and SmartSketch. 

http://support.intergraph.com/
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Site LAN – The Local Area Network (LAN) at a physical site that is associated with a site 
license machine. 
Site – The fixed geographic area surrounding the site license machine. 
Site License Machine – The computer where the key is loaded. The key contains a code that 
tells the license machine how many licenses of each type it can issue. The license machine can 
be a server or a standard computer. 
 

Setup Options 
There are several options for setting up SmartPlant License Manager license machines and 
clients.  Because licensing has little impact on computer performance, any computer can be 
licensed. 
Please contact Intergraph support if you need assistance setting up your license configuration. 

See Also 
Upgrades and License Keys (on page 15) 
Configure and Test Options (on page 38) 
General Topics FAQ (on page 76) 
 

License Example 
In connected license mode, a SmartPlant License Manager site license machine is configured to 
manage the SmartPlant License Manager licenses. 
For example, XYZ Engineering Ltd. purchases one license key that contains four SmartPlant 
Review licenses and three licenses of each of its seven modules. 
To manage these licenses, the site administrator configures a networked machine to be the 
SmartPlant License Manager licensing machine, then installs and configures both SmartPlant 
Review and SmartPlant License Manager on the workstations within the company. 
When a user starts SmartPlant Review on an individual workstation, one license for the core 
SPR product and one license for each installed module is automatically obtained from the 
SmartPlant License Manager license machine. This means that if this particular workstation has 
all seven modules installed, then eight (one core and seven module) licenses are used by this 
workstation. When the SmartPlant Review session ends, the licenses are automatically returned 
to the SmartPlant License Manager license machine. Those licenses are now available for use 
by another SmartPlant Review session on a networked workstation. 
To continue this example, up to three SmartPlant Review sessions using seven modules each 
can be running concurrently. A fourth SmartPlant Review session can also run concurrently 
since there is one remaining core SPR license. However, this fourth session cannot run any 
modules because all of the module licenses are in use. If this fourth SPR session has modules 
installed, SmartPlant Review attempts to find licenses for the installed modules then displays a 
"no licenses available" message and closes the session. To run this fourth session without 
attempting to obtain licenses for the installed modules, use the SmartPlant Review Select 
Modules Utility to specify which installed modules you want to license. 

See Also 
Upgrades and License Keys (on page 15) 
Configure and Test Options (on page 38) 
General Topics FAQ (on page 76) 
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S E C T I O N  2  

This section provides detailed information about installing SmartPlant License Manager, 
requesting and installing upgrades, and requesting and installing license keys. 

 
 SmartPlant License Manager installation will stop if another instance of SmartPlant License 

Manager or PD_Lice is currently installed.  The following error message displays, Another 
version of this product is already installed. Installation of this version cannot 
continue. To configure or remove the existing version of this product, use 
Add/Remove Programs on the Control Panel. 

 The SmartPlant License Manager license machine supports NTFS on the root drive only. 
 The SmartPlant License Manager license machine will not work if a virtual private network 

(VPN) is installed.  VPN is not a supported configuration for SmartPlant License Manager. 
 The SmartPlant License Manager license machine does not support multiple network 

devices, such as a network interconnect controller (NIC) team, on a single system. 
 In a networked configuration where the user's workstations are accessing one or more 

engineering application machines, install SmartPlant License Manager on a separate 
node.  Do not install SmartPlant License Manager on the application machine. SmartPlant 
License Manager is not supported when configured on a machine running Windows 
Terminal Server and/or products such as Citrix Server. 

See Also 
Installation of SmartPlant License Manager (on page 19) 
Upgrades and License Keys (on page 15) 
Software Installation that Requires Licensing (on page 18) 
 

Upgrades and License Keys 
The SmartPlant License Manager License Request form does not issue an upgrade of the 
product that requires licensing. An upgrade is not required unless it is needed for work or 
production purposes. 

See Also 
License Key Requests for the License Machine (on page 16) 
Software Version Compatibility (on page 16) 
Configure and Test Options (on page 38) 
General Topics FAQ (on page 76) 
 

License Requests and Installation 
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Software Version Compatibility 
For the most current compatibility matrix, refer to the eCustomer Web site  
(https://crmweb.intergraph.com/ecustomer_enu). 

See Also 
License Key Requests for the License Machine (on page 16) 
 

License Key Requests for the License Machine 
SmartPlant License Manager uses the Generate Machine ID command to uniquely identify the 
license machine where the license will be installed. You must generate a Machine ID on the 
license machine and send the resulting code to Intergraph before you can obtain a new or 
updated license key. When you run Start > Programs > Intergraph SmartPlant License 
Manager > Generate Machine ID, a file is created that contains the code needed to send to 
Intergraph. 

  If you upgrade to SmartPlant License Manager version 2010, any previously 
installed key will not work.  You must generate a new machine ID and request a SmartPlant 
License Manager version 2010 key.  

 
 The SmartPlant License Manage license machine is not fully functional when 

communicating across any network device that obscures the client's IP address.  This 
includes, but is not limited to, NAT routers and VPN solutions.  VPN solutions are not 
supported by SmartPlant License Manager. 

 Your generated machine ID will contain your SmartPlant License Manager version number. 
 Your generated machine ID will contain the TCP/IP address for the machine used to create 

the machine ID. 
 For SmartPlant License Manager 2010, the machine ID value begins with a value of 6. 
 There is a minimum and maximum value for a machine ID.  It must be between 128 and 

136 characters. 
 There is a maximum of 32,767 total seats per license key. 
The following describes installing SmartPlant License Manager. 

If the license machine does not contain SmartPlant License 
Manager 
1. Install SmartPlant License Manager using the Installation media or download the SmartPlant 

License Manager product from the eCustomer Web site 
(https://crmweb.intergraph.com/ecustomer_enu). 

2. On your designated license machine, click Start > Programs > Intergraph SmartPlant 
License Manager > Generate Machine ID. 

3. Select Browse on the Generate Machine ID dialog box and define a path and file name for 
the Machine ID. This file will be a text file. 

 If no path is defined, the location of the created Machine ID file defaults to the 
executable location (for example, C:\Win32App\INGR\SPLM\Bin). 

See Also 
Software Version Compatibility (on page 16) 
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License Key Requests 
After generating the Machine ID for the license machine, send the text file and the completed 
License Key Request form in an e-mail message to Intergraph using this address: 
ppmserv@intergraph.com. An Intergraph Software Delivery representative will e-mail your key 
to you within 48 hours of receipt of your request. 
You can also call Intergraph Process, Power & Marine (PPM) Support. In the United States, call 
1-800-766-7701 for the Global Order Desk. (Follow Support and Sales phone links.) 

 
 When you remove and re-install SmartPlant License Manager, you must generate a new 

machine ID and request a new license key.  You cannot reuse the previously generated 
machine ID. 

 If you remove SmartPlant License Manager or remove the existing key after generating and 
sending the Machine ID to Intergraph, the new license key you receive from Intergraph from 
the previous SmartPlant License Manager installation will not install. 

 If you re-run the Generate Machine ID command, it will invalidate the existing Machine ID. 
The following warning displays when you re-run the Generate Machine ID command. Note 
that this warning message displays when you use the command from the Start menu but not 
from the Command Prompt (when entering splmGenMachineID.exe). 

 
If you have already sent the Machine ID in an e-mail message to Intergraph but not yet received 
your license key, select No to not generate a new Machine ID. Otherwise, the key you receive 
from Intergraph will not install. 
If you generate a new Machine ID after installing the license key, the license machine will 
continue to work. However, you will have to submit this new Machine ID to Intergraph when 
requesting a new or updated license key. 
The number of licenses covered by a license key is the same as the total number of licenses 
that you purchased or leased for each LAN ID listed for that license machine. Intergraph records 
are used to determine the correct number of licenses for the key. 
In cases where the system will not be connected to a network, such as running a laptop, the 
SmartPlant License Manager license machine and the client are the same machine.  For 
example, a laptop would be supported as a license client.  The Select a License Machine for a 
Client (on page 39) section explains how to specify the laptop name as the SmartPlant License 
Manager license machine.  A separate license key is required unless you are using SmartPlant 
Review or SmartSketch and check out a license for use on your laptop. 
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eLicense and Generating SmartPlant License Manager Keys 
Customers using the eLicense web site to manage their licenses receive them immediately by 
e-mail.   If you do not have access to the eLicense web site, please contact your Purchasing 
Agent or Engineering Manager to request read and/or write privileges. 
1. Log onto eLicense (https://ppmapps.intergraph.com/ELICENSE/ 

(https://ppmapps.intergraph.com/elicense/)). 
2. Select your lease (OrderID) using the search option. You can apply filters to your search to 

select the lease. 
3. Click the Show Results button. 
4. You are now on the Order Summary screen. Click the Edit Server button. 
5. The Server screen displays. In the Server Type column, select the drop-down list and 

select MachineID. To generate SmartPlant License Manager keys, select MachineID. 
6. Copy the Machine ID from the email and paste it into the MachineID column on the Server 

screen. 
The ServerType determines the key that will be generated. The product determines which 
ServerType is selected. 
DiskSerialNbr = SPF 
DomainName = XPDA 
Machine ID = SPLM keys 
HostName = SPF, Marian, INtools 6.0 or earlier 

7. Using the scroll bar at the bottom of the Server screen, scroll to the right to show the 
Change Seat Count button. 

8. You are now ready to generate the SmartPlant License Manager key. Click the Generate 
Key button. 

9. On the Generate Keys screen, select SPLM in the Key Type column. 
10. If the export restrictions are accepted, click Next. 
11. Select your country from the Country drop-down list. 
12. Click the Key Generate button. The key has now been generated. 

See Also 
Key-in Commands Overview (on page 89) 
Alphabetical List of Key-in Commands (on page 89) 
 

Software Installation that Requires Licensing 
Install SmartPlant License Manager on every machine before installing any of the licensed 
products. During setup, products automatically search for SmartPlant License Manager on the 
machine. If it is not installed, a message box displays as shown in the following example. 

 

See Also 
Software Installation Using the Web (on page 23) 
 

https://ppmapps.intergraph.com/elicense/
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S E C T I O N  3  

Before beginning the product installation, refer to the delivered SmartPlant License Manager 
readme file for the latest product installation updates. The readme file is delivered in the top 
level product folder of the product media. Be sure you have the latest version of the SmartPlant 
License Manager software before beginning the installation. If you do not have the latest version 
of the software, you can install it using http://ppmapps.intergraph.com/elicense 
(http://ppmapps.intergraph.com/elicense). 

 SmartPlant License Manager 2010 (v11) can be upgraded to SmartPlant License 
Manager 2012 (v12). Any existing license key will be invalidated after the upgrade to SmartPlant 
License Manger 2012 (v12). You will also need to generate a new computer ID and request a 
new key. If you upgrade the SmartPlant License Manager 2010 (v11) license computer to a 
SmartPlant License Manager 2012 (v12) client by mistake, you will have to un-install the 
SmartPlant License Manager client and reinstall SmartPlant License Manager 2012 (v12) 
license computer. 

Hardware Configurations 
The SmartPlant License Manager licensing computer software should be installed on a stable, 
single node, hardware configuration (such as a simple PC), with a static IP address, because 
license key installation and license seat usage authentication depends on the information 
gathered from the physical hardware. Any automated changes that cause the hardware 
information not to match with the information used to generate the license key will result in a 
failure of the authentication process. 
Virtual (including VMware®), shadowed, mirrored, dynamic, or distributed hardware 
configurations cannot be used as a SmartPlant License Manager licensing computer. This 
includes terminal (application) servers, networked and distributed storage management 
systems, and so forth. When these specialized systems occur in the user's network, the 
SmartPlant License Manager Server licensing computer should be installed on a separate 
dedicated hardware configuration system. The SmartPlant License Manager licensing computer 
should be situated on the user's network where it can be accessed by all systems that are 
running application software that relies on the SmartPlant License Manager licensing computer 
for license management.  
Multiple SmartPlant License Manager licensing computers can be used in the user's network as 
long as each system is a unique hardware system/installation. If SmartPlant License Manager 
licensing computers are cloned after the license key has been installed, then the license 
management will fail on the cloned system. Each SmartPlant License Manager licensing 
computer requires its own unique license key. 

  
 RAID (redundant array of independent disks) and SAN (storage area networks) are not 

supported on a SmartPlant License Manager license computer. 
 The license computer must have the same version (or later) of SmartPlant License Manager 

installed as any client computers. In other words, you cannot use a newer version on a client 
computer to retrieve a license from an older version of SmartPlant License Manager on the 

Installation of SmartPlant License 
Manager 

http://ppmapps.intergraph.com/elicense
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licensing computer. The license computer must have the same version (or a newer version) 
installed than the clients. 

 You must log in as Administrator to install this software. 
1. Insert the Intergraph SmartPlant License Manager media. If the media does not start 

automatically, double-click Setup.exe in the root folder of the media. 
   During SmartPlant License Manger installation automatically turns on a product 

usage log file in C:\Win32App\Ingr\SPLM\bin\loggingfileV12.txt. You can 
change this location and name of this file as it can grow to be a large file.  If you stop and 
restart logging, you need to define the output location.  
This file can grow very large and users can redefine the location and name of this file. 

2. Select SmartPlant License Manager Installation. 
3. Click Next on the Welcome to the InstallShield Wizard for SmartPlant License Manager 

page. 
4. Enter your name and company name in the User Name and Company Name fields on the 

Customer Information page. Click Next. 
5. On the Software License Agreement page, select your country from the list and click 

Display to view the license agreement. 
  The license agreement is delivered as a PDF file. 

6. Carefully read the license agreement. Close the PDF document, and click Yes on the 
License Agreement page to accept the terms. 

7. Select either License Client or License Machine. 
8. On the Choose Destination Location page, click Next to install SmartPlant License 

Manager in the default location. If you want to install the software in another location, click 
Change and select the new location. 

  It is recommended that you install SmartPlant License Manager using a path that 
contains no spaces, such as c:\win32app\Ingr (the default path). 

9. Click Install on the Ready to Install the Program page. A status bar displays the progress 
of the installation on the Status Setup page. 

10. Click Finish on the InstallShield Wizard Complete page to complete installation of 
SmartPlant License Manager. 

 Do not delete any files that are created during installation or as a result of using 
SmartPlant License Manager. Removal of any files causes the license system to fail and 
can require install, repair, or possibly removal and re-install of SmartPlant License Manager. 

11. Add pdlice.exe to both the license computer and the client computer after installing of 
SPLM. You may need to remove pdlice.exe and re-add it if you uninstall and reinstall 
SPLM to upgrade SPLM from previous version to a current version. Otherwise, you may 
receive a Connection timed out error message when you start your application.  You may 
also see the same error in your scavenging log file. 

See Also 
Software Installation Using the Web (on page 23) 
Silent Mode and SmartPlant License Manager Installation (on page 25) 
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Quick Installation Workflow 
Use this workflow for all products that require SmartPlant License Manager concurrent licensing. 
The System Administrator completes or gives guidance about most of these steps. Administrator 
rights are required to install and setup SmartPlant License Manager. If you need more 
information, follow the detailed procedures in the other sections. For more information, refer to 
Frequently Asked Questions (FAQ) (on page 75), Functions of SmartPlant License Manager 
(see "Functions of SmartPlant License Manager: License Machine" on page 33), and 
Troubleshooting and Error Messages (see "Appendix G:  Troubleshooting and Error Messages" 
on page 119). 

  Please refer to the delivered SmartPlant License Manager Readme for all the latest 
product installation updates. 
1. Designate a computer as the SmartPlant License Manager license computer. This computer 

must be on the network and have a name with no spaces and a static IP address.  
2. Install SmartPlant License Manager on the license computer and generate a computer ID.  
3. Request a license key from the Intergraph Order Desk or generate a license key using 

eLicense.  
4. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 

License Manager.  
5. Click Install and Remove and Install License Key commands.  
6. Click License Machine and enter the license key you received. If the license key installs 

correctly, SmartPlant License Manager software automatically closes. 
7. Next, install SmartPlant License Manager on each client computer.  
8. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 

License Manager.  
9. Click Configure and Test and Select License Machine for Client.  
10. Enter the SmartPlant License Manager computer name. Exit SmartPlant License Manager.  
11. Install the software that requires licensing. For example, SmartPlant Review, PDS or 

SmartPlant P&ID. Use that product's installation and configuration guides to install each 
product.  

12. Use the Test Seat Reservation and Test Seat Release commands to ensure that 
communication is working between the license computer and the client. Successful 
messages show appropriate communication.  

13. Click Test Seat Reservation. Select the license computer name and Batch or Interactive 
mode. Note the seat number in the SmartPlant License Manager Information dialog box to 
enter.  

14. Click Test Seat Release and enter the seat designated in the SmartPlant License Manager 
Information dialog box.   

15. Start the software product that requires SmartPlant License Manager licensing.  
16. For information about firewalls, please refer to Appendix E:  Microsoft Windows Firewall 

and SmartPlant License Manager (on page 111).  

See Also 
Upgrades and License Keys (on page 15) 
Configure and Test Options (on page 38) 
General Topics FAQ (on page 76) 
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Installation Checklist 
For the recommended installation workflow, refer to the installation checklist named 
SPLMInstall_Checklist.xls. The file is available on the product media in the CDSetup\Help folder. 
A file named SPLMInstall_Checklist.pdf is also available in the same folder. 

See Also 
Upgrades and License Keys (on page 15) 
Configure and Test Options (on page 38) 
General Topics FAQ (on page 76) 
 

PDS and SmartPlant License Manager Installation 
Follow this procedure for PDS only. For all other products, follow the procedures in SmartSketch 
and SmartPlant License Manager Installation (on page 22) or SmartPlant Products and 
SmartPlant License Manager Installation (on page 23). 
1. Insert the PDS media into the drive. 
2. Navigate to the SmartPlant License Manager directory on the media. 
3. Double-click setup.exe. The SmartPlant License Manager Installation Welcome dialog 

box appears. 
4. Click Continue. The Software License Agreement appears. 
5. Read the license agreement and click I Agree. The Intergraph SmartPlant License 

Manager Setup dialog box appears. 
6. Select either License Client or License Machine. 
7. Select a folder and click Continue. 
The Intergraph SmartPlant License Manager software is now installed. You are ready to run 
SmartPlant License Manager on the client machines to point them to a license on the license 
machine. 

  When you start the PD_XPDA product, a PDS 3D license is used. 
 

SmartSketch and SmartPlant License Manager 
Installation 

Follow this procedure for SmartSketch only.  Refer to PDS and SmartPlant License Manager 
Installation (on page 22) or SmartPlant Products and SmartPlant License Manager Installation 
(on page 23) for installation details about other SmartPlant products. 

 
 SmartSketch Standalone does not require SmartPlant License Manager to be installed. 
 If you currently have SmartPlant License Manager installed, you must remove the existing 

product before you install the product again. If you re-install SmartPlant License Manager, 
you must request new keys from Intergraph for the license machine. 

SmartPlant Licensing Manager must be installed on every machine running the products it 
licenses. If it is not installed, the products will not operate. A message box asking to install 
SmartPlant License Manager appears at the end of a product’s Setup if SmartPlant Licensing 
Manager is not on the machine. Click Yes to install SmartPlant Licensing Manager from the 
product media or (for some products) from the Intergraph eCustomer Web site. 
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1. Insert the SmartPlant License Manager media into the drive. 
2. In the /SmartPlant License Manager folder, double-click setup.exe. The SmartPlant License 

Manager Installation Welcome dialog box appears. 
3. Click Continue. The Software License Agreement appears. 
4. Read the license agreement and click I Agree. The Intergraph SmartPlant License 

Manager Setup dialog box appears. 
5. Select either License Client or License Machine. 
6. Select a folder and click Continue. The SmartPlant License Manager software is now 

installed. You are ready to run SmartPlant License Manager on the client machines to point 
them to a license on the license machine. 

 

SmartPlant Products and SmartPlant License 
Manager Installation 

Follow this procedure for SmartPlant products that require SmartPlant License Manager.  Refer 
to PDS and SmartPlant License Manager Installation (on page 22) or SmartSketch and 
SmartPlant License Manager Installation (on page 22) for installation details for other products. 

  If you currently have SmartPlant License Manager installed, you must remove the 
existing product before you install the product again. If you re-install SmartPlant License 
Manager, you must request new keys from Intergraph for the license machine. 
SmartPlant Licensing Manager must be installed on every machine running the products it 
licenses. If it is not installed, the products will not operate. A message box asking to install 
SmartPlant License Manager appears at the end of a product’s Setup if SmartPlant Licensing 
Manager is not on the machine. Click Yes to install SmartPlant Licensing Manager from the 
product media or (for some products) from the Intergraph eCustomer Web site. 
1. Insert the SmartPlant License Manager media into the drive. 
2. In the /SmartPlant License Manager folder, double-click setup.exe. The SmartPlant License 

Manager Installation Welcome dialog box appears. 
3. Click Continue. The Software License Agreement appears. 
4. Read the license agreement and click I Agree. The Intergraph SmartPlant License 

Manager Setup dialog box appears. 
5. Select either License Client or License Machine. 
6. Select a folder and click Continue. The SmartPlant License Manager software is now 

installed. You are ready to run SmartPlant License Manager on the client machines to point 
them to a license on the license machine. 

 

Software Installation Using the Web 
In addition to installing from CDs, some products can be installed from the Intergraph 
eCustomer Web site. This example uses SmartPlant License Manager, but all products are 
available on the Products List. Check to see if your product can be installed from the Web site. 
1. Log in as Administrator. 
2. Go to the eCustomer web site:  https://crmweb.intergraph.com/ecustomer_enu 
3. Enter your user name and password. 

  If you are a new customer or do not have a user name and password, click the I'm a 
New User link to obtain your user name and password. 

4. Select the Service tab. 
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5. Click Download Software Updates. 
6. Click Products. 
7. Select SmartPlant License Manager. 
8. Click Save to download the SmartPlant License Manager Zip file to your computer. 
9. Open the SmartPlant License Manager Zip file and double-click setup.exe. 
10. After the files are extracted to your computer, click Continue to install SmartPlant License 

Manager. 
11. Read the Software License Agreement carefully, and if you agree to the specified terms, 

click I Agree. 
12. Select either License Client or License Machine. 
13. Specify the location where you want SmartPlant License Manager installed and click 

Continue. 
14. When the installation process is complete, click OK. 
15. Follow the instructions in the Running SmartPlant License Manager to configure SmartPlant 

License Manager. 

See Also 
Software Installation that Requires Licensing (on page 18) 
Upgrades and License Keys (on page 15) 
 

Laptops and SmartPlant License Manager Installation 
1. Download the latest SmartPlant License Manager software from the eCustomer Web Site. 

(https://crmweb.intergraph.com/ecustomer 
(https://crmweb.intergraph.com/ecustomer_enu/start.swe?SWECmd=Start&amp;SWEHo=cr
mweb.intergraph.com)) 

2. Install SmartPlant License Manager in the default folder. 
3. Disable all the network connections, except for the Loopback Adapter, before generating the 

Machine ID. 
4. Select Generate Machine ID from the Intergraph SmartPlant License Manager program 

group. 
  Do not attempt to generate the Machine ID more than once. 

5. Send the Machine ID output to Intergraph to request a license key. 
  If all the previous steps described in this section are performed correctly, SmartPlant 

License Manager works with or without a network connection. No extra step is required when 
the laptop is connected to a network. 

See Also 
Appendix C: Installing SmartPlant License Manager on a Standalone System (on page 103) 
Appendix E:  Microsoft Windows Firewall and SmartPlant License Manager (on page 111) 
 

https://crmweb.intergraph.com/ecustomer_enu/start.swe?SWECmd=Start&amp;SWEHo=crmweb.intergraph.com
https://crmweb.intergraph.com/ecustomer_enu/start.swe?SWECmd=Start&amp;SWEHo=crmweb.intergraph.com
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Silent Mode and SmartPlant License Manager 
Installation 

To silently install SmartPlant License Manager Client, use the following steps. 
 If UAC is on, you must have administrative privileges in the Command Prompt window to 

successfully complete a silent install or silent uninstall.  Select Start > Programs > 
Accessories.  Select and right-click Command Prompt.  Click Run as administrator.  If you 
do not have administrative privileges, the silent install or silent uninstall will fail.  You will not 
receive an error message in the Command Prompt window. 
1. Open a Command Prompt window from the Start menu.  You must have administrative 

privileges to complete the following steps. 
2. At the command prompt, type: 

<path>\SPLM\setup.exe /s /v"SLAACCEPT=Yes SPLMSETUPTYPE=Client /qn" 
To silently install SmartPlant License Manager License Machine, use the following steps. 
1. Open a Command Prompt window using the Start menu. 
2. At the command prompt, type: 

<path>\SPLM\setup.exe /s /v"SLAACCEPT=Yes 
SPLMSETUPTYPE=LicenseMachine /qn" 
For example, \\machinename\SmartPlant License 
Manager\SPLM2012\SPLM\Setup.exe /s /v"SLAACCEPT=Yes 
SPLMSETUPTYPE=LicenseMachine /qn" 

To silently uninstall, enter the following command. 
<path>\SPLM\setup.exe /s /x /v /qn 

 
 If SLAACCEPT=Yes is not included on the command line, an error log will be created in the 

TEMP folder. You can find an example file named MSI63ffd.LOG in the TEMP folder.  It 
contains an error similar to the following: "The software license agreement has not 
been accepted. *** Logging stopped: 8/19/2009 13:12:12 ***" 

 If the SPLMSETUPTYPE= property is not used on the command line, the client will be 
installed by default. 
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Upgrades for SmartPlant License Manager 
An upgrade from SmartPlant License Manager 2010 (v11) to SmartPlant License Manager 2012 
(v12) is available. Changes to SmartPlant License Manager 2012 will have little to no effect on 
how users operate on a daily basis. 
You do not need to upgrade to SmartPlant License Manager 2012 unless an application is 
requiring SmartPlant License Manager 2012. SmartPlant License Manager 2012 on the license 
machine supports all current and previous versions of SmartPlant License Manager on client 
machines. 
New features for SmartPlant License Manager 2012 include the following. 
 A new counted type seat for the license key is now available for use by some products.  
 Supports more than 100 product tags. 
 Certified on Microsoft Windows 7 and Windows Server 2008 R2. 
 Added options for Test Seat Reservation and Test Seat Release using the Current User 

registry settings to obtain the list of license machines. 
 More products are now supported by SmartPlant License Manager. Please check the SPLM 

PPM Compatibility Matrix on eCustomer for the latest SPLM supported products. 

Before Upgrading to SmartPlant License Manager 2012 (v12) 
  You must complete the following before you can upgrade SmartPlant License 

Manager. 
 If you currently have SmartPlant License Manager 2010 (v11.00.17.00) installed on your 

license machine, you can upgrade to SmartPlant License Manager 2012 (v12) directly, but 
you must generate a new Machine ID and request a new key after the upgrade.  

 If you currently have SmartPlant License Manager 2008 (v10) or previous version installed 
on your license machine, you must uninstall existing SmartPlant License Manager version 
prior to installing SmartPlant License Manager 2012 (v12). You must generate a new 
Machine ID and request a new license key after the upgrade.  

 To minimize downtime during the upgrade, you can pre-request a SmartPlant License 
Manager 2012 license key for your SmartPlant License Manager v11 or older version of 
License Machine. Please refer to the detailed instructions in this document.  

 SmartPlant License Manager 2012 v12 License Machine supports all previous versions of 
SmartPlant License Manager on Client Machines. 

 SmartPlant applications may experience seat releasing errors while the SmartPlant License 
Manager license machine is being upgraded.  This is normal and should not happen after a 
SmartPlant License Manager 2012 (v12) key is installed on the upgraded license machine. 
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Upgrading to SmartPlant License Manager 2012 
Upgrading to SmartPlant License Manager 2012 License 
Machine 
This section describes three scenarios when upgrading to SmartPlant License Manager 2012 
(v12) on your license machine. Please read these scenarios thoroughly before proceeding. 

Scenario 1:    New Install - If you have not installed SmartPlant License Manager on your 
License Machine yet 
1. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps.  
2. Choose to install SmartPlant License Manager License Machine. 
3. After you have installed SmartPlant License Manager, click Start > All Programs > 

Intergraph SmartPlant License Manager > Generate Machine ID. 
4. Select Browse (…) button and define the path and filename for the Machine ID. 
5. Send your Machine ID file to ppmserv@intergraph.com or your regional office and request a 

SmartPlant License Manager license key.  
  If you have access to eLicense you can generate SmartPlant License Manager key 

yourself https://ppmapps.intergraph.com/ELICENSE/Logon.aspx 
6. Open SmartPlant License Manager on your license machine and install your license key. 

Scenario 2:    Upgrade before a new SmartPlant License Manager 2012 Key is Requested 
If you are not concerned waiting for a SmartPlant License Manager 2012 key, or if you have 
eLicense site access to cut your own SmartPlant License Manager keys, you can follow the 
instructions below.  
If you have SmartPlant License Manager 2010 (v11) installed on your license machine, 
use the following steps. 
1. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps.  
2. The setup will perform the upgrade.  
3. After you have upgraded SmartPlant License Manager, click Start > All Programs > 

Intergraph SmartPlant License Manager > Generate Machine ID. 
4. Select Browse (…) button and define the path and filename for the Machine ID. 
5. Send your Machine ID file to ppmserv@intergraph.com or your regional office and request a 

SmartPlant License Manager license key.  
  If you have access to eLicense you can generate SmartPlant License Manager key 

yourself https://ppmapps.intergraph.com/ELICENSE/Logon.aspx 
6. Open SmartPlant License Manager on your license machine and install your license key. 
If you are running SmartPlant License Manager 2008 (v10) or older version on your 
license machine. 
1. Uninstall existing SmartPlant License Manager on your license machine 
2. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps.  
3. Choose to install SmartPlant License Manager License Machine. 
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4. After you have installed SmartPlant License Manager, click Start > All Programs > 
Intergraph SmartPlant License Manager > Generate Machine ID. 

5. Send your Machine ID file to ppmserv@intergraph.com or your regional office and request a 
SmartPlant License Manager license key.  

  If you have access to eLicense you can cut a key yourself.  Use the following link. 
https://ppmapps.intergraph.com/ELICENSE/Logon.aspx 

6. Open SmartPlant License Manager on your license machine and install your license key. 

Scenario 3:    Pre-request a new SmartPlant License Manager 2012 Key before the 
Upgrade 
You can pre-request SmartPlant License Manager 2012 (v12) license key before upgrading your 
current SmartPlant License Manager v11 (or older versions) to SmartPlant License Manager 
2012 to keep your downtime at a minimum.  
1. Download SmartPlant License Manager 2012 Generate Machine ID executable 

(splmGenMachineID_2012.exe) from the eCustomer web site (link to 
http://crmweb.intergraph.com and select Service > Download Software Updates > Products 
> SPLM) or from the eLicense web site.      

2. Copy the splmGenMachineID_2012.exe to a temporary folder on your current SmartPlant 
License Manager license machine (e.g. c:\temp) 

3. Open Command Prompt, go to the directory where you saved the 
splmGenMachineID_2012.exe (for example, c:\temp folder), then run the executable with 
the output file as an argument. For example,  
splmGenMachineID_2012.exe c:\temp\v12machineID.txt 

  If you are running Microsoft Windows 7 or Windows Server 2008, you must 
right-click on Command Prompt, and then choose Run as administrator option to open it.  

4. The Machine ID file should be created in your specified output location. Send the machine 
ID file to ppmserv@intergraph.com or to your regional office to request SPLM v12 key.  

  If you have access to eLicense you can also cut a key yourself 
https://ppmapps.intergraph.com/ELICENSE/Logon.aspx 

5. Do NOT run the Generate Machine ID utility. 
6. After you have received your SmartPlant License Manager 2012 license key, upgrade your 

SmartPlant License Manager License machine:  
 If your license machine is currently running SPLM 2010 (v11), you need to over-install 

SmartPlant License Manager 2012 (v12). You can run setup.exe from your SmartPlant 
License Manager 2012 installation media and follow the upgrade steps.  

 If your License Machine is currently running SmartPlant License Manager 2008 (v10) or 
older version, you must uninstall the existing SmartPlant License Manager first, then run 
setup.exe from your SmartPlant License Manager 2012 installation media and follow the 
steps to install SmartPlant License Manager 2012.  

7. Do NOT run the Generate Machine ID utility. 
8. Open SmartPlant License Manager on your license machine and install your license key. 
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Upgrading to SmartPlant License Machine 2012 Client 
This section describes two scenarios when upgrading to SmartPlant License Manager 2012 
(v12) on your client machine. Please read these scenarios thoroughly before proceeding.  

Scenario #1:  New SmartPlant License Manager Installation - If you have not installed 
SmartPlant License Manager Client 
1. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps.  
2. Choose to install SmartPlant License Manager Client. 
3. After you have installed SmartPlant License Manager Client, right-click on SmartPlant 

License Manager then open with Run as administrator option. 
4. Select Configure and Test then click Select. 
5. Click Select License machine for Client then click Select. 
6. Type in your SmartPlant License Manager 2012 License Machine node name or IP.  
7. Click OK, and then click Close to exit out SmartPlant License Manager.  

Scenario #2:  Upgrade an existing SmartPlant License Manager Client 
If you are running SmartPlant License Manager 2010 (v11) on your Client machine, use 
the following steps. 
1. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps 
2. The setup will perform the upgrade.  
3. After you have upgraded SmartPlant License Manager Client, right-click on SmartPlant 

License Manager then open with Run as administrator option. 
4. Select Configure and Test then click Select. 
5. Click Select License machine for Client then click Select. 
6. Type in your SmartPlant License Manager 2012 License Machine node name or IP.  
7. Click OK, and then click Close to exit out SmartPlant License Manager.  
If you are running SmartPlant License Manager 2008 (v10) or older version on your Client 
machine, use the following steps. 
1. Uninstall existing SmartPlant License Manager on your client machine 
2. Run setup.exe from your SmartPlant License Manager 2012 installation media and follow 

the steps.  
3. Choose to install SmartPlant License Manager Client. 
4. After you have installed SmartPlant License Manager Client, right-click on SmartPlant 

License Manager then open with Run as administrator option. 
5. Select Configure and Test then click Select. 
6. Click Select License machine for Client then click Select. 
7. Type in your SmartPlant License Manager 2012 License Machine node name or IP.  
8. Click OK, and then click Close to exit out SPLM.  
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Recommendations 
The following information is provided for use when upgrading to SmartPlant License Manager 
2012 (v12). 
 SmartPlant applications may experience seat releasing errors while the SmartPlant License 

Manager License machine is being upgraded. This is normal and should not happen after a 
SmartPlant License Manager 2012 (v12) key is installed on the upgraded license machine. 

 Error messages may be displayed indicating failure to return the seats to the upgraded 
license machine. These errors can be ignored. 

 Do not run the Generate Machine ID command again after you submitted your machine ID 
file to request a SmartPlant License Manager license key.  Running generate machine ID 
again will invalidate the machine ID file you submitted and you will not be able to install the 
key generated based on that machine ID file.  

 If you have further questions please contact 1-800–766-7701 or open a service request via 
the eCustomer Web site: http://crmweb.intergraph.com/ http://crmweb.intergraph.com/. 

 

About SmartPlant License Manager 
After you have installed SmartPlant License Manager, you can easily find the installation date, 
version number, release date, the user name, and node name. 
1. On the main SmartPlant License Manager dialog, click Help > About SmartPlant License 

Manager to display the About SmartPlant License Manager information dialog box. 

See Also 
Starting SmartPlant License Manager (on page 30) 
 

Starting SmartPlant License Manager 
The Start > Programs > Intergraph SmartPlant License Manager command contains the 
Generate Machine ID and SmartPlant License Manager icons. 
1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 

License Manager to begin using SmartPlant License Manager.  The SmartPlant License 
Manager dialog box appears. Intergraph recommends reading the Readme file included 
with every release. 

 

http://crmweb.intergraph.com/
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See Also 
Select a License Machine for a Client (on page 39) 
Install a License Key (on page 34) 
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S E C T I O N  4  

The following sections describe administrative tasks for the license machine including 
configuring and testing licenses, monitoring license usage, returning unused licenses, and so 
forth.  For information about client options, refer to Functions of SmartPlant License Manager: 
Client (on page 60). 

See Also 
Scavenge Options (on page 49) 
Configure and Test Options (on page 38) 
Display Options (on page 52) 
 

Install and Remove Options 
When the SmartPlant License Manager is successfully installed, you can install a license key or 
stop and restart your licensing service. This section covers installing a license key, installing and 
starting or stopping and removing Licensing Service. 

  If a machine has been used as a SmartPlant License Manager client, and then it is 
decided to use the machine as a SmartPlant License Manager license machine, the SmartPlant 
License Manager software must be removed first. 
Use the following procedure to access the Install and Remove Options dialog box. 
 Click Install and Remove on the SmartPlant License Manager dialog box. The Install 

and Remove Options dialog box displays. 

 

See Also 
Install a License Key (on page 34) 
Install and Start the Licensing Service (on page 36) 
Stop and Remove the Licensing Service (on page 37) 

Functions of SmartPlant License 
Manager: License Machine 
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Install a License Key 
After SmartPlant License Manager is installed and you have received your license key from 
Intergraph, you are ready to install the license key on the license machine. The key can be 
installed any time during the 72-hour period that begins with the installation date you provide. 
For example, if you request 01-July-2008 as the installation date, the key can be installed on 
01-July, 02-July, or 03-July. 
This command requires administrator privileges on the license machine. 

 
 For SmartPlant License Manager 2010, the license key with begin with a value of 2. 
 License machines with a high volume of network traffic, including seat requests and seat 

returns, should split the licenses onto multiple machines for  better licensing performance. 
 In a Command Prompt window, you can type pdlice -a license_key, where license_key is 

the series of alphanumeric characters that make up the license key. 
 Do not remove an existing license key if you are using SmartPlant License Manager 8.0 or 

later. If you have already requested a new license key by sending your Machine ID, you 
should not remove the existing license key. Otherwise, the new license key obtained from 
Intergraph will not install and you need to re-generate the machine ID and request another 
license key. 

 You will not be able to install a license key while scavenging is running. The following error 
message displays: The license key could not be installed while scavenge is running. 
Please try again. 

The number of characters in a license key is determined by the number of product tags actually 
in the license key.  For example, a license key could look similar to the following. 
0yeibppymfahfqhqrdmeedsn7r6fqmfnfdaalwnowjnodrdh3wbvkkmn7r8jde6dfnfwnd7 
jenm7dbf79sdiqn43jmcjwl7c3bj53ifq8hsfdcth5t9ragaqrbg9v9silorjmvbsgclfi3 
tjdppbp9njcinp88n5i85udv8qn8vpjjl1edpm8nbc39flnlkc6doktcd47enofaqfdps85 
cbmhriijdfy95nkh55h7j3egopledffcldhpmm85ycf58vfl8cjf9f1pjdgbobldtl 
Use the following procedure to install your license key. 
1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 

License Manager to start SmartPlant License Manager. The SmartPlant License Manager 
dialog box appears. 

2. Click Install and Remove on the SmartPlant License Manager dialog box. 
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3. Click Install License Key. The Install License Key dialog box appears. 

 
4. Enter your license key in the License key field. The OK button activates when you enter a 

valid license key. 

 
 You can copy and paste the license key into the License Key field.  You must select 

the license key, copy the selected key, and paste the key into the License Key field.  
You cannot double-click the license key to select it. 

 The SmartPlant License Manager software will not display your key once it is 
successfully installed.  Please keep the license key e-mail message from Intergraph (in 
case you need to refer to your license key at a later date). 

5. The type of key is automatically defined as License machine. 
  After a machine ID is generated successfully, all license machine options will be 

available.  Also, if you use the pdlice -c command, some of the license machine options 
are no longer available. When you use the Generate Machine ID command, all license 
machine options are again available. 

6. Click OK.  If the key installs correctly, SmartPlant License Manager automatically closes. 
7. Open SmartPlant License Manager again and verify that the key installed correctly. Click 

Show Key Status on the Display Options dialog box. For more information, refer to Show 
Key Status (on page 53). 

8. Be sure to close the application prior to reserving a license. 
After SmartPlant License Manager verifies the license key, the license database is installed. 
Then you can begin setting up the client computers that will be reserving licenses. 
For information about setting up client computers, refer to Configure and Test Options (on page 
38). 

See Also 
Select a License Machine for a Client (on page 39) 
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Install and Start the Licensing Service 
Use the following procedure to install and start your license service. 

 
 This command adds the service.  To remove the service, refer to Stop and Remove the 

Licensing Service (on page 37). 
 If you install SmartPlant License Machine client on Windows Vista, Windows 7, Windows 

Server 2008, or Windows Server 2008 R2 and you have UAC turned on, and if your login 
belongs to local administrator's group, you need to right-click and start SmartPlant License 
Manager or a DOS window using the Run as administrator option. Or, you can go to 
License.exe, right-click and go to Properties, turn on Run this program as an 
administrator option in Compatibility. Otherwise, you receive an Access denied error 
message. 

1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager to start SmartPlant License Manager. The SmartPlant Licensing 
Manager dialog box appears. 

2. Click Install and Remove on the SmartPlant License Manager dialog box. The Install 
and Remove Options dialog box appears. 

 
3. Click Install and Start Licensing Service. 
4. Click Select.   

The system displays a message box indicating that the SmartPlant License Manager service 
is starting. 
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The system displays a message box indicating that the license service is successfully 
installed and started. 

 
5. Click OK to dismiss the information dialog box. 

See Also 
Install a License Key (on page 34) 
 

Stop and Remove the Licensing Service 
Use the following procedure to stop and remove your license service.  The command stops the 
software without leaving any process active. 

 
 Using this command removes the service.  To add the service, refer to Install and Start the 

Licensing Service (on page 36). 
 If you install SmartPlant License Machine client on Windows Vista, Windows 7, Windows 

Server 2008, or Windows Server 2008 R2, and you have UAC turned on, and if your login 
belongs to local administrator's group, you need to right-click and start SmartPlant License 
Manager or a DOS window using the Run as administrator option. Or, you can go to 
License.exe, right-click and go to Properties, turn on Run this program as an 
administrator option in Compatibility. Otherwise, you receive an Access denied error 
message. 

1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager to start SmartPlant License Manager. The SmartPlant Licensing 
Manager dialog box appears. 

2. Click Stop and Remove Options on the SmartPlant License Manager dialog box. The 
Install and Remove Options dialog box appears. 

 
3. Click Stop and Remove Licensing Service. 
4. Click Select. 
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The system displays a message box indicating that the license service is successfully 
removed. 

 
5. Click Yes to stop and remove the licensing service. 

 
6. Click OK to dismiss the message box indicating that the licensing service has been 

successfully stopped and removed. 

 

See Also 
Install and Start the Licensing Service (on page 36) 
Install a License Key (on page 34) 
 

Configure and Test Options 
When the SmartPlant License Manager key is successfully installed, you can configure and test 
your client computers. This section covers selecting a license machine for a client, removing a 
client from the license machine, displaying and modifying the license usage, and reserving and 
unreserving a seat. 
Use the following procedure to access the Configure and Testing Options dialog box. 
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1. Click Configure and Test on the SmartPlant License Manager dialog box. The Configure 
and Test Options dialog box appears. 

 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Log Product Usage (on page 56) 
 

Select a License Machine for a Client 
Use the following procedure to select a license machine for a client.  You can also add more 
than one license machine at a time by defining the license machine names separated by a 
space.  For example, licensemachine1 licensemachine2 licensemachine3.   

 
 If you install SmartPlant License Machine client on Windows Vista or Windows Server 2008, 

and you have UAC turned on, and if your login belongs to local administrator's group, you 
need to right-click and start SmartPlant License Manager or a DOS window using the Run 
as administrator option. Or, you can go to License.exe, right-click and go to Properties, 
turn on Run this program as an administrator option in Compatibility. Otherwise, you 
receive an Access denied error message. 

 You must have administrative privileges to use this command. 
 The maximum number of allowed license machines is 25. 
 No spaces are allowed in the actual license machine name. 
 SmartPlant License Manager client searches available licenses on the licensing machines in 

the order they were added. If you would like the client to locate a license from a particular 
licensing machine first, then that machine needs to be on the top of the list. You can use 
Display License Machine for Client - All Users (on page 55) option to check the order of 
licensing machines. 

 If you are working in a heterogeneous environment, you need to use the license machine's 
IP address instead of the actual name (Machine name). 

 To verify that the computer correctly points to the license machine, refer to Display the 
License Machine for a Client - Current User Only (on page 56). 

 To test checking out (reserving) a license on the client computer, refer to Test Seat 
Reservation (on page 42). 
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 To release the license you just reserved, refer to Test Seat Release (on page 44). 
1. Log onto each computer that will reserve a license (including, possibly, the license machine 

itself), and make sure SmartPlant License Manager is installed. 
2. On the Configuration and Testing dialog box, click Select License Machine For Client. 

(Or, type pdlice –j in a Command Prompt window.) The Select License Machine For Client 
dialog box appears. 

 
3. Type the computer name(s) of your license machine in the Machine name field. The license 

machine name can be a maximum length of 29 characters and can contain no spaces. 
4. Click OK. If you want to add another license machine name, repeat step 2. 

See Also 
Install a License Key (on page 34) 
 

Remove License Machine for a Client 
Use the following procedure to remove a license machine from the client's license machine list. 
   The SmartPlant License Manager license machine value displayed when Select 

License Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:  There are no license machines to display for this user under HKCU. 

1. Click Remove License Machine for Client on the Configure and Test dialog box. (Or, 
type pdlice –k in a Command Prompt window.) The Remove License Machine for Client 
dialog box appears.  This option removes the license machine name and the internet 
address from the registry. 

 
2. Type the name of the license machine you want to remove in the Machine name field. If 

you selected your license machine using the Select License Machine For Client option, 
the license machine name automatically appears in the Machine name field or you can 
select it from the list. 

3. Click OK. The SmartPlant License Manager Information box appears. 
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See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
Log Product Usage (on page 56) 
 

Display and Modify License Usage 
Users can specify whether daily keys can be used by interactive users only, interactive and 
batch users, batch users only, or neither. By default, a daily key cannot be activated without 
selecting this option. This command requires administrator privileges. These options are 
available only on the license machine. 
Daily seats, once activated, expire in 12 hours, regardless of how much actual processing time 
has been used. When a process that uses a daily license seat completes and the 12-hour period 
for that daily license seat has not expired, that daily license seat becomes available for use by 
other processes regardless of which job started the daily seat. For example, if you only have 
Allow interactive jobs to start new daily seats option selected, once the interactive job 
finishes and the daily seat has not expired, Batch job can also use that daily seat.  
If a job is running at the end of the 12-hour period, the job is allowed to complete processing. 
When the processing is complete, the daily license key then expires. To display the status of the 
daily license keys, refer to Displaying the Status of Active PDS Daily Licenses. 

 
 If a daily license is activated and in use on a SmartPlant Manager License Manager server 

that has daily seat ONLY key installed, a new key will not install until the reserved daily seat 
is returned. There is no warning message.  However, a blank install key window displays. 
To resolve this, close the SmartPlant License Manager application, verify that all in use daily 
licenses are returned, and then install a new license key. 

 If you cannot access your PDS PID Standalone or Frameworks Plus licenses, check to be 
sure that you used the correct serial number when either product was installed 

 By default, SmartPlant License Manager assigns a regular seat.  If none are available, a 
daily seat is assigned.  You must select Allow interactive jobs to start new daily seats to 
enable daily seat selection. 

 These options are available only for the SmartPlant License Manager license machine. 
Use the following procedure to activate daily keys in PDS. 
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1. Click Display and Modify License Usage. (Or, type pdlice –Q in a Command Prompt 
window.) The Display and Modify License Usage dialog box appears. 

 
2. Place a check mark beside the option you want to use. 

Allow interactive jobs to start new daily seats – Allows the product's daily license keys to 
be started by interactive users if checked. Daily licenses are active for one 12-hour period. 
Allow batch jobs to start new daily seats – Allows the product's daily license keys to be 
started by batch users if checked. Daily licenses are active for one 12-hour period. 
Allow PDS 2D to use higher- level PDS seats, if available – Allows PDS 2D license seats 
to use higher-level seats, if any are available. This option applies only to PDS P&ID, IDM, 
and PDS 2D seats. For example, if no 2D seats (licenses) are available this option allows 
use of a 3D seat (license).  

3. Type the number of days you want a warning message to display prior to the license key 
expiration date in the Days field.  The number of days must be greater than 0 (zero) and 
less than 768. 

4. In the Seats field, type the total number of non-concurrent seats being used that will trigger 
a warning message.  The number of remaining seats must be greater than 0 (zero). 

See Also 
Configure and Test Options (on page 38) 
Log Product Usage (on page 56) 
 

Test Seat Reservation 
Use the following procedure to test whether a license can be reserved from the client. This is 
especially helpful in testing license machine and client communication after installation. 

 
 When running this command, if you have no license key installed or you have a version prior 

to SmartPlant License Manager 2012 selected, the message "There are no tags in the key 
on the license machine xxx." and a blank product tag list will display.  

 If the IP address of the SmartPlant License Manager license machine is changed after you 
have installed a SmartPlant License Manager key, the Product Tag list in the Test Seat 
Reservation dialog box will be empty.  When you install a new key using the updated IP 
address, the Product Tag list will display the correct tags. 
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 If a license request is not completed because the license machine is busy or scavenging, 
then SmartPlant License Manager automatically submits the request for a license again. 

 The default mode for testing a seat reservation is Interactive. 
 If you purchased a PDS PID license, only the PDS PID application is available to use. If you 

purchased PDS 2D, the PDS PID, IDM, and PFD applications are available to use. 
 A batch job will not display any warning about a lack of seats because the batch job will wait 

until it can retrieve the seat. Only interactive jobs will return a warning message when a seat 
is not available.  For example, a PD_Model batch submission will wait until it can retrieve 
five seats.  If five seats cannot be retrieved, the system waits until you successfully delete 
the job from the queue. 

1. Click Test Seat Reservation on the Configuration and Testing dialog box. The Test Seat 
Reservation dialog box appears. 

 
2. Set the applicable options. 

License machine – Select the name of the license machine to define where the seat will be 
reserved. 
Batch – Activates batch processing mode.  If a license is not immediately available, the 
process tries to start the batch request again until it is successful.  If the batch process has 
not started within 12 hours, then no more attempts are made to start the request. 
Interactive – Activates interactive processing mode. 
Time (Min) – Defines how long a client machine will wait to get a license seat in minutes (if 
there is not one available). The Test Seat Reservation dialog box remains open until the 
defined wait time is over or until there is a license seat available. The license machine you 
are requesting wait time on must have SmartPlant License Manager installed and a valid 
license key assigned.  
Product Tag – Use the drop-down list to select the appropriate product, as detailed in the 
following table.  Connect to the Intergraph eCustomer web site 
(https://crmweb.intergraph.com) to view the latest SmartPlant License Manager list of 
available product tags. 

   
 If you are using a SmartPlant License Manager 2012 (v12) license machine, the 

Product Tag list only display the licenses that are available from the SmartPlant 
License Manager 2012 (v12) license machine. 

 A blank (or empty) product tag list may display after you select a license machine.  This 
may occur if the selected SmartPlant License Manager version on the license machine 
is older than the SmartPlant License Manager version that is installed on the client 
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machine.  This may also occur if the SmartPlant License Manager service is not 
running on the selected license machine, or if the selected license machine has a 0 
(zero) key installed.  Also, if pdlice.exe has not been added to the Exception List for 
Microsoft Windows Firewall on the SmartPlant License Manager license machine, a 
blank tag list can display. 

 If you are using the PDS product, the domain name is not used when logging product 
usage. 

3. Select your license machine name that automatically appears in the License machine field 
or select it from the drop-down list. 

4. Select Batch or Interactive. To execute this option as a batch process, click the Batch 
option. The Time (Min) and Product Tag fields activate. Type the wait time in minutes. 

5. Click the Product tag drop-down list and select the product tag. 
6. Click OK. 

The SmartPlant License Manager Information dialog box appears. If you are testing 
client-license machine communication, note the seat number in the dialog box. The seat 
number information will be used in the Test Seat Release command. 

See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
Log Product Usage (on page 56) 
 

Test Seat Release 
Use the following procedure to ensure that a seat has been unreserved or released from the 
license machine. 
1. Click Test Seat Release on the Configuration and Testing dialog box. 

 
2. If the node name does not automatically appear in the License machine name field, select 

it from the list or type the node name in the License machine name field. Type the 
assigned number of the seat in the Seat Number field. 

3. Click OK. 
The SmartPlant License Manager Information dialog box appears with confirmation or 
error information. 

See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
Log Product Usage (on page 56) 
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Select License Machine for Client (Current User) 
  Uninstalling SmartPlant License Manager does not remove the following registry entry. 

HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines 
Use the following procedure to select a license machine for a client.  You can also add more 
than one license machine at a time by defining the license machine names separated by a 
space.  For example, licensemachine1 licensemachine2 licensemachine3.   

 
 If you install SmartPlant License Machine client on Windows Vista or Windows Server 2008, 

and you have UAC turned on, and if your login belongs to local administrator's group, you 
need to right-click and start SmartPlant License Manager or a DOS window using the Run 
as administrator option. Or, you can go to License.exe, right-click and go to Properties, 
turn on Run this program as an administrator option in Compatibility. Otherwise, you 
receive an Access denied error message. 

 You must have administrative privileges to use this command. 
 The maximum number of allowed license machines is 25. 
 No spaces are allowed in the actual license machine name. 
 SmartPlant License Manager client searches available licenses on the licensing machines in 

the order they were added. If you would like the client to locate a license from a particular 
licensing machine first, then that machine needs to be on the top of the list. You can use 
Display License Machine for Client - All Users (on page 55) option to check the order of 
licensing machines. 

 If you are working in a heterogeneous environment, you need to use the license machine's 
IP address instead of the actual name (Machine name). 

 To verify that the computer correctly points to the license machine, refer to Display the 
License Machine for a Client - Current User Only (on page 56). 

 To test checking out (reserving) a license on the client computer, refer to Test Seat 
Reservation (on page 42). 

 To release the license you just reserved, refer to Test Seat Release (on page 44). 
1. Log onto each computer that will reserve a license (including, possibly, the license machine 

itself), and make sure SmartPlant License Manager is installed. 
2. On the Configuration and Testing dialog box, click Select License Machine For Client. 

(Or, type pdlice –j in a Command Prompt window.) The Select License Machine For Client 
dialog box appears. 

 
3. Type the computer name(s) of your license machine in the Machine name field. The license 

machine name can be a maximum length of 29 characters and can contain no spaces. 
Click OK. If you want to add another license machine name, repeat step 2. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
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Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Reservation (Current User) (on page 47) 
Test Seat Release (Current User) (on page 49) 
 

Remove License Machine for Client (Current User) 
  If you remove a license machine for the current user, this also removes the license 

machine name stored in the registry.  But, the  
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry key is not 
removed.  
Use the following procedure to remove a license machine from the client's license machine list. 
   The SmartPlant License Manager license machine value displayed when Select 

License Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:  There are no license machines to display for this user under HKCU. 

1. Click Remove License Machine for Client on the Configure and Test dialog box. (Or, 
type pdlice –k in a Command Prompt window.) The Remove License Machine for Client 
dialog box appears.  This option removes the license machine name and the internet 
address from the registry. 

 
2. Type the name of the license machine you want to remove in the Machine name field. If 

you selected your license machine using the Select License Machine For Client option, 
the license machine name automatically appears in the Machine name field or you can 
select it from the list. 

3. Click OK. The SmartPlant License Manager Information box appears. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Select License Machine for Client (Current User) (on page 45) 
Test Seat Reservation (Current User) (on page 47) 
Test Seat Release (Current User) (on page 49) 
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Test Seat Reservation (Current User) 
Use the following procedure to test whether a license can be reserved from the client. This is 
especially helpful in testing license machine and client communication after installation. 

 
 When running this command, if you have no license key installed or you have a version prior 

to SmartPlant License Manager 2012 selected, the message "There are no tags in the key 
on the license machine xxx." and a blank product tag list will display.  

 If the IP address of the SmartPlant License Manager license machine is changed after you 
have installed a SmartPlant License Manager key, the Product Tag list in the Test Seat 
Reservation dialog box will be empty.  When you install a new key using the updated IP 
address, the Product Tag list will display the correct tags. 

 If a license request is not completed because the license machine is busy or scavenging, 
then SmartPlant License Manager automatically submits the request for a license again. 

 The default mode for testing a seat reservation is Interactive. 
 If you purchased a PDS PID license, only the PDS PID application is available to use. If you 

purchased PDS 2D, the PDS PID, IDM, and PFD applications are available to use. 
 A batch job will not display any warning about a lack of seats because the batch job will wait 

until it can retrieve the seat. Only interactive jobs will return a warning message when a seat 
is not available.  For example, a PD_Model batch submission will wait until it can retrieve 
five seats.  If five seats cannot be retrieved, the system waits until you successfully delete 
the job from the queue. 

1. Click Test Seat Reservation on the Configuration and Testing dialog box. The Test Seat 
Reservation dialog box appears. 

 
2. Set the applicable options. 

License machine – Select the name of the license machine to define where the seat will be 
reserved. 
Batch – Activates batch processing mode.  If a license is not immediately available, the 
process tries to start the batch request again until it is successful.  If the batch process has 
not started within 12 hours, then no more attempts are made to start the request. 
Interactive – Activates interactive processing mode. 
Time (Min) – Defines how long a client machine will wait to get a license seat in minutes (if 
there is not one available). The Test Seat Reservation dialog box remains open until the 
defined wait time is over or until there is a license seat available. The license machine you 



Functions of SmartPlant License Manager: License Machine 
 

 
48 SmartPlant License Manager Installation and User's Guide 

 

are requesting wait time on must have SmartPlant License Manager installed and a valid 
license key assigned.  
Product Tag – Use the drop-down list to select the appropriate product, as detailed in the 
following table.  Connect to the Intergraph eCustomer web site 
(https://crmweb.intergraph.com) to view the latest SmartPlant License Manager list of 
available product tags. 

   
 If you are using a SmartPlant License Manager 2012 (v12) license machine, the 

Product Tag list only display the licenses that are available from the SmartPlant 
License Manager 2012 (v12) license machine. 

 A blank (or empty) product tag list may display after you select a license machine.  This 
may occur if the selected SmartPlant License Manager version on the license machine 
is older than the SmartPlant License Manager version that is installed on the client 
machine.  This may also occur if the SmartPlant License Manager service is not 
running on the selected license machine, or if the selected license machine has a 0 
(zero) key installed.  Also, if pdlice.exe has not been added to the Exception List for 
Microsoft Windows Firewall on the SmartPlant License Manager license machine, a 
blank tag list can display. 

 If you are using the PDS product, the domain name is not used when logging product 
usage. 

3. Select your license machine name that automatically appears in the License machine field 
or select it from the drop-down list. 

4. Select Batch or Interactive. To execute this option as a batch process, click the Batch 
option. The Time (Min) and Product Tag fields activate. Type the wait time in minutes. 

5. Click the Product tag drop-down list and select the product tag. 
6. Click OK. 
The SmartPlant License Manager Information dialog box appears. If you are testing 
client-license machine communication, note the seat number in the dialog box. The seat number 
information will be used in the Test Seat Release command. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Select License Machine for Client (Current User) (on page 45) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Release (Current User) (on page 49) 
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Test Seat Release (Current User) 
Use the following procedure to ensure that a seat has been unreserved or released from the 
license machine. 
1. Click Test Seat Release on the Configuration and Testing dialog box. 

 
2. If the node name does not automatically appear in the License machine name field, select 

it from the list or type the node name in the License machine name field. Type the 
assigned number of the seat in the Seat Number field. 

3. Click OK. 
The SmartPlant License Manager Information dialog box appears with confirmation or error 
information. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Select License Machine for Client (Current User) (on page 45) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Reservation (Current User) (on page 47) 
 

Scavenge Options 
SmartPlant License Manager enables you to control license usage from the license machine 
and to find (scavenge) and return unused licenses. 
Use the following procedure to access the Scavenge Options dialog box. 
1. Log onto the license machine. (This option is available only on the license machine.) 
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2. Click Scavenge on the main SmartPlant License Manager dialog box.  The Scavenge 
Options dialog box appears. 

 

See Also 
Scavenge for Keys (on page 50) 
Display and Modify Scavenging Options (on page 51) 
 

Scavenge for Keys 
Scavenging for license keys finds licenses that have been reserved. This situation can happen 
when a computer fails while a license is reserved or an unexpected termination occurs. 
1. Click Scavenge for Keys on the Scavenging Options dialog box. (Or, type pdlice –n in a 

Command Prompt window.)  The SmartPlant License Information dialog box appears.  
The start and stop times for the scavenge process are included in the displayed information.  
The start time displays at the beginning of the details and the stop time displays at the end. 

 
If a license remains reserved when you think it should have been returned, check to be sure the 
process identified with the process ID is legitimate. This may involve asking the user who is 
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using the client node and checking to make sure that the process is still running by monitoring 
how much CPU time it is using. 
If obtaining an available license is a higher priority than preserving an active process, you can 
kill the process using Task Manager so the license it is using is made available. Use this drastic 
measure only when other options to get the license returned have failed. You must be absolutely 
certain that the process in question is no longer needed. 

See Also 
Display and Modify Scavenging Options (on page 51) 
Scavenge Options (on page 49) 
 

Display and Modify Scavenging Options 
Scavenging is automatically enabled for one minute past the hour. 

  
 If you want the modified settings to take effect immediately, you must stop and restart the 

SPLM - SmartPlant Licensing Manager service.  Otherwise, the modified settings will take 
effect at the next scheduled scavenge cycle. 

 When SmartPlant License Manager is installed, the scavenging log file is automatically 
enabled.  By default, the output log file is in  
C:\Win32App\INGR\SPLM\bin\scavengeV12.txt.  This file is only created after you 
install the license key on the SmartPlant License Manager license machine.  You can define 
a new location if needed using the Output file name option below.  
If the scavenging functionality is turned off and then back on, you will need to redefine the 
output location. This file will not be removed when SmartPlant License Manager is 
uninstalled.  If SmartPlant License Manager is reinstalled, it will append information to the 
existing file and output the scavenging result to the default file location. 

1. Click Display and Modify Scavenging Options on the Scavenge Options dialog box. (Or, 
type pdlice –N in a Command Prompt window.).  This command requires system 
administrator privileges.  The Display and Modify Scavenging Options dialog box 
appears. 

 
2. Set the applicable options. 

Time interval (minutes) – Modifies/sets scavenging time in minutes.   
  Sixty (60) minutes is the recommended scavenging time interval. 
Start time (Minutes past) – Sets a scavenging time to begin at any specified minute past 
the hour. Valid values are 0-59 minutes.  For example, if you set Time interval to 15 
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minutes and Start time to 1 minute, at 9:50 scavenge would run at 10:01, 10:16, 10:31, 
10:46, and so forth. Or, if you set Time interval to 15 minutes and Start time to 5 minutes, 
at 10:15 scavenge would run at 10:20, 10:35, 10:50, 11:05, and so forth. 
Output file name – Defines an output file name that contains your scavenging 
information.  If you are defining the output file to a shared folder located on a different 
machine, write permissions must exist for the domain user and the SmartPlant License 
Manager machine.  By default (as delivered), the output log file is in 
C:\Win32App\INGR\SPLM\bin\scavengeV12.txt. 

  The output file name must be located on a local drive on the SmartPlant License 
Manager license machine. 
Maximum output file size – Defines the maximum size of your output file.  If the 
scavenging data content size exceeds this defined output file size, the file is still created so 
that no scavenging record is excluded. 
Do not scavenge for unused seats – Click to place a check mark in the check box if you 
do not want the system to scavenge for unused seats. 

3. Click OK. 

See Also 
Scavenge for Keys (on page 50) 
Scavenge Options (on page 49) 
 

Display Options 
The Display Options commands display information in the SmartPlant License Information 
dialog box. In some fields on that dialog box, product abbreviations are used instead of the full 
product names.  Connect to the Intergraph eCustomer web site (https://crmweb.intergraph.com) 
to view the latest SmartPlant License Manager list of available product tags. 

   
 License machines with a high volume of network traffic, including seat requests and seat 

returns, should split the licenses onto multiple machines for  better licensing performance. 
 If you are using the PDS product, the domain name is not used when logging product 

usage. 
Use the following procedure to access the SmartPlant License Manager monitoring functions. 
1. Click Display on the main SmartPlant License Manager dialog box.  The Display 

Options dialog box appears. 

 

See Also 
Generate an Audit Code (on page 53) 
Display the Status of Active Daily Licenses (on page 54) 
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Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
Display License Machine for Client - All Users (on page 55) 
Display the License Machine for a Client - Current User Only (on page 56) 
 

Generate an Audit Code 
Intergraph Support Services uses the audit code from a customer’s system for monitoring and 
troubleshooting customer system issues. For example, Intergraph can help determine proper 
licensing involving new license machines and moving software. There is no need to generate an 
audit code unless Intergraph Support Services requests it. 
This audit code includes how many daily seats and counted seats (non-concurrent license) 
remain on a key. 

  Beginning with SmartPlant License Manager 2012, the letter C is the first character in 
the audit code. 
1. Click Generate Auditing Code on the Display Options dialog box. (Or, type pdlice –e in a 

Command Prompt window.)  The SmartPlant License Manager Information dialog box 
appears with the audit code. 

2. Click Save to save the audit code information to a text file. Send the text file to Intergraph. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
 

Show Key Status 
Use the following procedure to verify the correct installation of a license key or to check the 
status of the currently installed license key. 
1. Click Show Key Status on the Display Options dialog box. (Or, type pdlice –f in a 

Command Prompt window.) 
The SmartPlant License Information dialog box appears with the following information: 
node, address, key type, installation date, number of licenses, expiration date, and daily 
licenses (if purchased). You can save this displayed information to a file, print the 
information, review on-line Help, or close the dialog box. 

 SmartPlant License Manager version 2008 and earlier use BISO and IISO for Batch 
Isogen and Interactive Isogen in the Show Key Status dialog box. BISO and IISO have been 
changed to 4D and 5D. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
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Display the Status of Active Daily Licenses 
Monitoring the use of daily licenses includes information about daily licenses currently reserved, 
licenses currently active, and daily licenses available for future use. 

   
 PD_Model does not use a daily seat. 
 If a daily license is activated and in use on a SmartPlant Manager License Manager server 

that has daily seat ONLY key installed, a new key will not install until the reserved daily seat 
is returned. There is no warning message.  However, a blank install key window displays. 
To resolve this, close the SmartPlant License Manager application, verify that all in use daily 
licenses are returned, and then install a new license key. 

Use the following procedure to display the status of the daily keys. 
1. Click Display Status of Active Daily Licenses on the Display Options dialog box. (Or, 

type pdlice –M in a Command Prompt window.) 
The SmartPlant License Information dialog box displays. 

See Also 
Display Options (on page 52) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
 

Display the Status of Reserved Licenses 
Use the following procedure to display the status of the reserved licenses. 
1. Click Display Status of Reserved Licenses on the Display Options dialog box. (Or, type 

pdlice –m in a Command Prompt window.) 
The SmartPlant License Information dialog box displays. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
 

Display the Status of Expired and Unexpired Keys 
Use the following procedure to list information about other license machines on your LAN. The 
displayed information includes the license expiration date, total licenses and available licenses, 
computer IP address, and computer name. 
1. Click Display Status of Expired and Unexpired Keys on the Display Options dialog box. 

(Or, type pdlice –B in a Command Prompt window.) 
2. Click Select. 
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A three-minute timer runs while SmartPlant License Manager waits for replies. It is possible 
that some computers may not reply during this three-minute period. A message box 
appears, reminding you that this option takes time to run. 

 
3. Click Yes to continue. 

The system displays a message indicating that a search is being run for license machines. 

 
When the search completes, the SmartPlant License Manager Information dialog box 
appears. It contains data about all license machines on your LAN. You can save its 
displayed information to a file, print the information, review on-line Help, or close the dialog 
box. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
 

Display License Machine for Client - All Users 
Use the following procedure to display the list of license machines for a client and includes all 
users. 
1. Click Display License Machine for Client - All Users on the Display Options dialog box. 

The SmartPlant License Information dialog box appears. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
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Display the License Machine for a Client - Current User Only 
Use the following procedure to display the list of license machines for a client including only 
current users. 

 
 A license machine that is defined in the HK_Current_User does not roll over to a license 

machine defined using the SmartPlant License Manager interface (saved in 
HKLM_Current_User). 

 SmartPlant License Manager allows setting the license machine for each user account. 
Using the local administrator’s login, this can be defined at the registry key for the current 
user.  For example, 
[HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines]. 

 The SmartPlant License Manager license machine value displayed when Select License 
Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:   
There are no license machines to display for this user under HKCU. 

When the SmartPlant License Manager client software finds a license machine listed in the 
correct registry location for the current user, the license machine listed will silently take 
precedence over the Selected License Machine for Client configured in the SmartPlant 
License Manager software.  
To determine if a custom license machine has been configured for a given client, login as that 
client and select Display > Display License Machine for Client - Current User Only. 
1. Click Display License Machine for Client - Current User Only on the Display Options 

dialog box. 
The SmartPlant License Information dialog box appears. 

See Also 
Configure a License Machine for Current User (on page 100) 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
 

Log Product Usage 
Use the following procedure to track product usage. If enabled, the Log Product Usage 
command tracks all licenses requested by a client. For example, when SmartPlant P&ID is 
opened on a client machine, a record is written to the log file. The log file also records closing 
SmartPlant P&ID on the client machine. 
You can also enter pdlice -L in a Command Prompt window.  Options include: 
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pdlice -L 
pdlice -L 0 
pdlice -L 1 
 
pdlice -L 1 path\(filename) 

Displays current settings for usage logging.  Options include: 
Disables usage logging.  
Enables usage logging and sets a default file path.  The 
default path is C:\Documents and 
Settings\<username>\logging.txt 
Enables usage logging and you can define a specified path for 
the log file.  For example, pdlice -L 1 C:\Temp\logging.txt 

 

 
 The log file cannot be routed to a different machine.  The log file must be generated on the 

license machine. 
 If the logging report cannot be written to the provided output file, then by default, the report 

is written to your c:\temp directory.  Be sure that any provided output file name has the 
correct permissions so it can be created. 

 When a non-concurrent seat is reserved using the SmartPlant License Manager interface or 
from the Command Prompt, -999 is used as a seat number in the Log Product Usage log 
file.  The non-concurrent seat is not actually taken from SmartPlant License Manager 
license machine.  This is only used to confirm that the communications between SmartPlant 
License Manager license machine and the client is working. 

Product Log File Options 
Operator - Displays the assigned number for the user. 
SeatNo - Displays the seat number assigned to the user. 
Time - Displays the time that the seat was assigned. 
TimeString - Displays the time in hh:mm:ss format. 
Daily - Displays if the seat assigned is a daily license. 
ProcessID - Displays the identification of the process using the assigned seat.  A concurrent 
license reserved in SmartPlant License Manager displays a ProcessID = -1.  A non-concurrent 
license reserved in SmartPlant License Manager displays a ProcessID = -999. 
ProdTag - Displays the product tag for assigned seat.  

  
 A ProdTag value of 3D9 indicates a daily seat is unavailable. 
 The Product Tag recorded in the log file is truncated and can contain up to 3 characters. 

For example, for the SmartPlant P&ID application, the product tag is SPPD. This is 
recorded as SPP in the log file. 

Operator Operator value 

1 Get license 

2 Return license 

11 No license available when requested 

12 License returned by scavenge 

31 Reserve license using SmartPlant License Checkout 
Utility 

32 Return a checked out license using SmartPlant 
License Checkout Utility 
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41 Reserve a non-concurrent license 

42 Non-concurrent seat request failure 

Batch/Interactive - Displays if the work is a batch job or is being worked interactively. 
TCPIP - Displays the TCP/IP address of the computer for the assigned seat. 

  In a Citrix environment, this IP address will be the Citrix application server's IP 
address (where SmartPlant License Manager client was installed, not the remote client 
machine's IP address). 

NodeName - Displays the name of the computer for the assigned seat. 
UserName - Displays the name of the user for the assigned seat. 
DomainName - Displays the current domain name. 

  If you are using the PDS product, the DomainName field is not used. 
ProjectName - Displays the name of the current project. 
1. Select Log Product Usage on the SmartPlant License Manager main window and click 

Select.  The Log Product Usage dialog box appears. 

 
2. If you want to record product usage, click the Start logging option. To stop recording 

product usage, click Stop logging. 
3. Click in the Output file name field and enter the path and a file name for the output file that 

will contain the logging information. You can also click the Browse  button and select an 
existing file. Logging information is appended to an existing file.  You must have permission 
to write to this folder.  If a UNC path is used, the domain user and the SmartPlant License 
Manager machine must have write permission to the defined folder. 
If the log file cannot be written to, the software attempts to write the record into a file in the 
/temp directory.  The file is assigned the prefix SPLMLogData<number>.  The record will 
not be recorded if the file cannot be written.  If you are using the record's contents for 
another process, you must copy the record's contents while the file is open. 

4. Click OK. 
The SmartPlant License Manager Information dialog box appears with confirmation or 
error information. 

The following is an example of the text log file content. 
Operator, SeatNo, Time, TimeString, Daily, ProcessID, ProdTag, 
BatchInteractive, tcpip, NodeName, UserName, DomainName, ProjectName 
1, 143, 1209555000, 29-Apr-08 05:53:25, 0, 3954,  3D, 0, 129.100.000.00x, 
PDSNodeName1, pdsuser1, domainname.com, project1 
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2, 142, 1209555001, 29-Apr-08 05:53:28, 0, 3954,  3D, 0, 129.100.000.00x, 
PDSNodeName12, pdsuser2, domainname.com, project1 
1, 141, 1209555003, 29-Apr-08 05:53:41, 0, 3754,  3D, 0, 129.100.000.00x, 
PDSNodeName12, pdsuser1, domainname.com, project1 
2, 144, 1209555002, 29-Apr-08 05:53:47, 0, 3754,  3D, 0, 129.100.000.00x, 
PDSNodeName12, pdsuser3, domainname.com, project1 
12, 1721, 1209555000, 29-Apr-08 06:44:50, 0, 3342, SRP, 1, 129.100.000.00x, 
SP3DNodeName1, domainname.com, project1 
12, 1722, 1209555001, 29-Apr-08 06:44:50, 0, 636, SRP, 1, 129.100.000.00x, 
SP3DNodeName1, domainname.com, project1 
1, 1082, 1209555007, 29-Apr-08 06:45:17, 0, 3764, S3D, 0, 129.100.000.00x, 
SPRNodeName1, domainname.com, project1 

See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
 

SmartPlant License Information Dialog Box 
The SmartPlant License Manager Information dialog box displays requested information 
about SmartPlant License Manager. You can save its displayed information to a file, print the 
information, review on-line Help, or close the dialog box. 

  The SmartPlant License Manager Information dialog box can be resized so that all the 
available information can be viewed. 
The following SmartPlant License Manager Information dialog box shows that the license 
machine has been successfully added to the SmartPlant License Manager License Machine 
List. 
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See Also 
Select a License Machine for a Client (on page 39) 
Install a License Key (on page 34) 
 

Remove SmartPlant License Manager 
Use this procedure with caution and only when you want to remove the complete SmartPlant 
License Manager product from your computer. 

 
 If you are removing SmartPlant License Manager on a license machine where there are still 

licenses in use, the Could not return the license to SmartPlant License 
Manager.  SPLM Failed: Failed to release seat error message could display when users 
exit the client application.  This is normal.  You must exit the client application and open the 
client application again after the new key is installed. 

 Removing SmartPlant License Manager does not remove the SPLM and journal folders from 
the installation location.  You must manually remove the SPLM and journal folder. 

 When you remove SmartPlant License Manager, you must generate a new machine ID and 
request a new license key.  You cannot reuse the previously generated machine ID. 

1. Click Start > Control Panel.  The Control Panel window displays. 
2. Click Add or Remove Programs. 
3. Select SmartPlant License Manager. 
4. Click Remove. 

See Also 
SmartPlant License Manager Functions (see "Functions of SmartPlant License Manager: 
License Machine" on page 33) 
 

The following sections describe tasks for the SmartPlant License Manager client including 
configuring and testing licenses, monitoring license usage, returning unused licenses, and so 
forth.  For information about license machine options, refer to Functions of SmartPlant License 
Manager: License Machine (on page 33). 

See Also 
Installing and Removing Options (on page 61) 
Configuring and Testing Options (on page 64) 
Display Options Commands (on page 73) 
 

Functions of SmartPlant License 
Manager: Client 
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Installing and Removing Options 
When the SmartPlant License Manager is successfully installed, you can install a license key or 
stop and restart your licensing service. This section covers installing a license key, installing and 
starting or stopping and removing Licensing Service. 

  If a machine has been used as a SmartPlant License Manager client, and then it is 
decided to use the machine as a SmartPlant License Manager license machine, the SmartPlant 
License Manager software must be removed first. 
Use the following procedure to access the Install and Remove Options dialog box. 
 Click Install and Remove on the SmartPlant License Manager dialog box. The Install 

and Remove Options dialog box displays. 

 

See Also 
Install and Start Licensing Service (on page 61) 
Stop and Remove Licensing Service (on page 63) 
 

Install and Start Licensing Service 
Use the following procedure to install and start your license service. 

 
 This command adds the service.  To remove the service, refer to Stop and Remove the 

Licensing Service (on page 37). 
 If you install SmartPlant License Machine client on Windows Vista, Windows 7, Windows 

Server 2008, or Windows Server 2008 R2 and you have UAC turned on, and if your login 
belongs to local administrator's group, you need to right-click and start SmartPlant License 
Manager or a DOS window using the Run as administrator option. Or, you can go to 
License.exe, right-click and go to Properties, turn on Run this program as an 
administrator option in Compatibility. Otherwise, you receive an Access denied error 
message. 

1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager to start SmartPlant License Manager. The SmartPlant Licensing 
Manager dialog box appears. 
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2. Click Install and Remove on the SmartPlant License Manager dialog box. The Install 
and Remove Options dialog box appears. 

 
3. Click Install and Start Licensing Service. 
4. Click Select.   

The system displays a message box indicating that the SmartPlant License Manager service 
is starting. 

 
The system displays a message box indicating that the license service is successfully 
installed and started. 

 
Click OK to dismiss the information dialog box. 

See Also 
Install a License Key (on page 34) 
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Stop and Remove Licensing Service 
Use the following procedure to stop and remove your license service.  The command stops the 
software without leaving any process active. 

 
 Using this command removes the service.  To add the service, refer to Install and Start the 

Licensing Service (on page 36). 
 If you install SmartPlant License Machine client on Windows Vista, Windows 7, Windows 

Server 2008, or Windows Server 2008 R2, and you have UAC turned on, and if your login 
belongs to local administrator's group, you need to right-click and start SmartPlant License 
Manager or a DOS window using the Run as administrator option. Or, you can go to 
License.exe, right-click and go to Properties, turn on Run this program as an 
administrator option in Compatibility. Otherwise, you receive an Access denied error 
message. 

1. Click Start > Programs > Intergraph SmartPlant License Manager > SmartPlant 
License Manager to start SmartPlant License Manager. The SmartPlant Licensing 
Manager dialog box appears. 

2. Click Stop and Remove Options on the SmartPlant License Manager dialog box. The 
Install and Remove Options dialog box appears. 

 
3. Click Stop and Remove Licensing Service. 
4. Click Select. 

The system displays a message box indicating that the license service is successfully 
removed. 
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5. Click Yes to stop and remove the licensing service. 

 
6. Click OK to dismiss the message box indicating that the licensing service has been 

successfully stopped and removed. 

 

See Also 
Install and Start the Licensing Service (on page 36) 
Install a License Key (on page 34) 
 

Configuring and Testing Options 
When the SmartPlant License Manager key is successfully installed, you can configure and test 
your client computers. This section covers selecting a license machine for a client, removing a 
client from the license machine, displaying and modifying the license usage, and reserving and 
unreserving a seat. 
Use the following procedure to access the Configure and Testing Options dialog box. 
1. Click Configure and Test on the SmartPlant License Manager dialog box. The Configure 

and Test Options dialog box appears. 

 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
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Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Log Product Usage (on page 56) 
 

Select License Machine 
Use the following procedure to select a license machine for a client.  You can also add more 
than one license machine at a time by defining the license machine names separated by a 
space.  For example, licensemachine1 licensemachine2 licensemachine3.   

 
 If you install SmartPlant License Machine client on Windows Vista or Windows Server 2008, 

and you have UAC turned on, and if your login belongs to local administrator's group, you 
need to right-click and start SmartPlant License Manager or a DOS window using the Run 
as administrator option. Or, you can go to License.exe, right-click and go to Properties, 
turn on Run this program as an administrator option in Compatibility. Otherwise, you 
receive an Access denied error message. 

 You must have administrative privileges to use this command. 
 The maximum number of allowed license machines is 25. 
 No spaces are allowed in the actual license machine name. 
 SmartPlant License Manager client searches available licenses on the licensing machines in 

the order they were added. If you would like the client to locate a license from a particular 
licensing machine first, then that machine needs to be on the top of the list. You can use 
Display License Machine for Client - All Users (on page 55) option to check the order of 
licensing machines. 

 If you are working in a heterogeneous environment, you need to use the license machine's 
IP address instead of the actual name (Machine name). 

 To verify that the computer correctly points to the license machine, refer to Display the 
License Machine for a Client - Current User Only (on page 56). 

 To test checking out (reserving) a license on the client computer, refer to Test Seat 
Reservation (on page 42). 

 To release the license you just reserved, refer to Test Seat Release (on page 44). 
1. Log onto each computer that will reserve a license (including, possibly, the license machine 

itself), and make sure SmartPlant License Manager is installed. 
2. On the Configuration and Testing dialog box, click Select License Machine For Client. 

(Or, type pdlice –j in a Command Prompt window.) The Select License Machine For Client 
dialog box appears. 

 
3. Type the computer name(s) of your license machine in the Machine name field. The license 

machine name can be a maximum length of 29 characters and can contain no spaces. 
Click OK. If you want to add another license machine name, repeat step 2. 

See Also 
Remove License Machine (on page 66) 
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Test for Seat Reservation (on page 66) 
Test for Seat Release (on page 68) 
 
 
 

Remove License Machine 
Use the following procedure to remove a license machine from the client's license machine list. 
   The SmartPlant License Manager license machine value displayed when Select 

License Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:  There are no license machines to display for this user under HKCU. 

1. Click Remove License Machine for Client on the Configure and Test dialog box. (Or, 
type pdlice –k in a Command Prompt window.) The Remove License Machine for Client 
dialog box appears.  This option removes the license machine name and the internet 
address from the registry. 

 
2. Type the name of the license machine you want to remove in the Machine name field. If 

you selected your license machine using the Select License Machine For Client option, 
the license machine name automatically appears in the Machine name field or you can 
select it from the list. 

3. Click OK. The SmartPlant License Manager Information box appears. 

See Also 
Select License Machine (on page 65) 
Test for Seat Reservation (on page 66) 
Test for Seat Release (on page 68) 
 

Test for Seat Reservation 
Use the following procedure to test whether a license can be reserved from the client. This is 
especially helpful in testing license machine and client communication after installation. 

 
 When running this command, if you have no license key installed or you have a version prior 

to SmartPlant License Manager 2012 selected, the message "There are no tags in the key 
on the license machine xxx." and a blank product tag list will display.  

 If the IP address of the SmartPlant License Manager license machine is changed after you 
have installed a SmartPlant License Manager key, the Product Tag list in the Test Seat 
Reservation dialog box will be empty.  When you install a new key using the updated IP 
address, the Product Tag list will display the correct tags. 

 If a license request is not completed because the license machine is busy or scavenging, 
then SmartPlant License Manager automatically submits the request for a license again. 
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 The default mode for testing a seat reservation is Interactive. 
 If you purchased a PDS PID license, only the PDS PID application is available to use. If you 

purchased PDS 2D, the PDS PID, IDM, and PFD applications are available to use. 
 A batch job will not display any warning about a lack of seats because the batch job will wait 

until it can retrieve the seat. Only interactive jobs will return a warning message when a seat 
is not available.  For example, a PD_Model batch submission will wait until it can retrieve 
five seats.  If five seats cannot be retrieved, the system waits until you successfully delete 
the job from the queue. 

1. Click Test Seat Reservation on the Configuration and Testing dialog box. The Test Seat 
Reservation dialog box appears. 

 
2. Set the applicable options. 

License machine – Select the name of the license machine to define where the seat will be 
reserved. 
Batch – Activates batch processing mode.  If a license is not immediately available, the 
process tries to start the batch request again until it is successful.  If the batch process has 
not started within 12 hours, then no more attempts are made to start the request. 
Interactive – Activates interactive processing mode. 
Time (Min) – Defines how long a client machine will wait to get a license seat in minutes (if 
there is not one available). The Test Seat Reservation dialog box remains open until the 
defined wait time is over or until there is a license seat available. The license machine you 
are requesting wait time on must have SmartPlant License Manager installed and a valid 
license key assigned.  
Product Tag – Use the drop-down list to select the appropriate product, as detailed in the 
following table.  Connect to the Intergraph eCustomer web site 
(https://crmweb.intergraph.com) to view the latest SmartPlant License Manager list of 
available product tags. 

   
 If you are using a SmartPlant License Manager 2012 (v12) license machine, the 

Product Tag list only display the licenses that are available from the SmartPlant 
License Manager 2012 (v12) license machine. 

 A blank (or empty) product tag list may display after you select a license machine.  This 
may occur if the selected SmartPlant License Manager version on the license machine 
is older than the SmartPlant License Manager version that is installed on the client 
machine.  This may also occur if the SmartPlant License Manager service is not 
running on the selected license machine, or if the selected license machine has a 0 
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(zero) key installed.  Also, if pdlice.exe has not been added to the Exception List for 
Microsoft Windows Firewall on the SmartPlant License Manager license machine, a 
blank tag list can display. 

 If you are using the PDS product, the domain name is not used when logging product 
usage. 

3. Select your license machine name that automatically appears in the License machine field 
or select it from the drop-down list. 

4. Select Batch or Interactive. To execute this option as a batch process, click the Batch 
option. The Time (Min) and Product Tag fields activate. Type the wait time in minutes. 

5. Click the Product tag drop-down list and select the product tag. 
6. Click OK. 
The SmartPlant License Manager Information dialog box appears. If you are testing 
client-license machine communication, note the seat number in the dialog box. The seat number 
information will be used in the Test Seat Release command. 

See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
Log Product Usage (on page 56) 
 

Test for Seat Release 
Use the following procedure to ensure that a seat has been unreserved or released from the 
license machine. 
1. Click Test Seat Release on the Configuration and Testing dialog box. 

 
2. If the node name does not automatically appear in the License machine name field, select 

it from the list or type the node name in the License machine name field. Type the 
assigned number of the seat in the Seat Number field. 

3. Click OK. 
The SmartPlant License Manager Information dialog box appears with confirmation or 
error information. 

See Also 
Configure and Test Options (on page 38) 
Display and Modify License Usage (on page 41) 
Log Product Usage (on page 56) 
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Select License Machine for Client - Current User 
  Uninstalling SmartPlant License Manager does not remove the following registry entry. 

HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines 
Use the following procedure to select a license machine for a client.  You can also add more 
than one license machine at a time by defining the license machine names separated by a 
space.  For example, licensemachine1 licensemachine2 licensemachine3.   

 
 If you install SmartPlant License Machine client on Windows Vista or Windows Server 2008, 

and you have UAC turned on, and if your login belongs to local administrator's group, you 
need to right-click and start SmartPlant License Manager or a DOS window using the Run 
as administrator option. Or, you can go to License.exe, right-click and go to Properties, 
turn on Run this program as an administrator option in Compatibility. Otherwise, you 
receive an Access denied error message. 

 You must have administrative privileges to use this command. 
 The maximum number of allowed license machines is 25. 
 No spaces are allowed in the actual license machine name. 
 SmartPlant License Manager client searches available licenses on the licensing machines in 

the order they were added. If you would like the client to locate a license from a particular 
licensing machine first, then that machine needs to be on the top of the list. You can use 
Display License Machine for Client - All Users (on page 55) option to check the order of 
licensing machines. 

 If you are working in a heterogeneous environment, you need to use the license machine's 
IP address instead of the actual name (Machine name). 

 To verify that the computer correctly points to the license machine, refer to Display the 
License Machine for a Client - Current User Only (on page 56). 

 To test checking out (reserving) a license on the client computer, refer to Test Seat 
Reservation (on page 42). 

 To release the license you just reserved, refer to Test Seat Release (on page 44). 
1. Log onto each computer that will reserve a license (including, possibly, the license machine 

itself), and make sure SmartPlant License Manager is installed. 
2. On the Configuration and Testing dialog box, click Select License Machine For Client. 

(Or, type pdlice –j in a Command Prompt window.) The Select License Machine For Client 
dialog box appears. 

 
3. Type the computer name(s) of your license machine in the Machine name field. The license 

machine name can be a maximum length of 29 characters and can contain no spaces. 
4. Click OK. If you want to add another license machine name, repeat step 2. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
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Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Reservation (Current User) (on page 47) 
Test Seat Release (Current User) (on page 49) 
 

Remove License Machine - Current User 
Use the following procedure to remove a license machine from the client's license machine list. 
   The SmartPlant License Manager license machine value displayed when Select 

License Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:  There are no license machines to display for this user under HKCU. 

1. Click Remove License Machine for Client on the Configure and Test dialog box. (Or, 
type pdlice –k in a Command Prompt window.) The Remove License Machine for Client 
dialog box appears.  This option removes the license machine name and the internet 
address from the registry. 

 
2. Type the name of the license machine you want to remove in the Machine name field. If 

you selected your license machine using the Select License Machine For Client option, 
the license machine name automatically appears in the Machine name field or you can 
select it from the list. 

3. Click OK. The SmartPlant License Manager Information box appears. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
 

Test Seat Reservation - Current User 
Use the following procedure to test whether a license can be reserved from the client. This is 
especially helpful in testing license machine and client communication after installation. 

 
 When running this command, if you have no license key installed or you have a version prior 

to SmartPlant License Manager 2012 selected, the message "There are no tags in the key 
on the license machine xxx." and a blank product tag list will display.  

 If the IP address of the SmartPlant License Manager license machine is changed after you 
have installed a SmartPlant License Manager key, the Product Tag list in the Test Seat 
Reservation dialog box will be empty.  When you install a new key using the updated IP 
address, the Product Tag list will display the correct tags. 
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 If a license request is not completed because the license machine is busy or scavenging, 
then SmartPlant License Manager automatically submits the request for a license again. 

 The default mode for testing a seat reservation is Interactive. 
 If you purchased a PDS PID license, only the PDS PID application is available to use. If you 

purchased PDS 2D, the PDS PID, IDM, and PFD applications are available to use. 
 A batch job will not display any warning about a lack of seats because the batch job will wait 

until it can retrieve the seat. Only interactive jobs will return a warning message when a seat 
is not available.  For example, a PD_Model batch submission will wait until it can retrieve 
five seats.  If five seats cannot be retrieved, the system waits until you successfully delete 
the job from the queue. 

1. Click Test Seat Reservation on the Configuration and Testing dialog box. The Test Seat 
Reservation dialog box appears. 

 
2. Set the applicable options. 

License machine – Select the name of the license machine to define where the seat will be 
reserved. 
Batch – Activates batch processing mode.  If a license is not immediately available, the 
process tries to start the batch request again until it is successful.  If the batch process has 
not started within 12 hours, then no more attempts are made to start the request. 
Interactive – Activates interactive processing mode. 
Time (Min) – Defines how long a client machine will wait to get a license seat in minutes (if 
there is not one available). The Test Seat Reservation dialog box remains open until the 
defined wait time is over or until there is a license seat available. The license machine you 
are requesting wait time on must have SmartPlant License Manager installed and a valid 
license key assigned.  
Product Tag – Use the drop-down list to select the appropriate product, as detailed in the 
following table.  Connect to the Intergraph eCustomer web site 
(https://crmweb.intergraph.com) to view the latest SmartPlant License Manager list of 
available product tags. 

   
 If you are using a SmartPlant License Manager 2012 (v12) license machine, the 

Product Tag list only display the licenses that are available from the SmartPlant 
License Manager 2012 (v12) license machine. 

 A blank (or empty) product tag list may display after you select a license machine.  This 
may occur if the selected SmartPlant License Manager version on the license machine 
is older than the SmartPlant License Manager version that is installed on the client 
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machine.  This may also occur if the SmartPlant License Manager service is not 
running on the selected license machine, or if the selected license machine has a 0 
(zero) key installed.  Also, if pdlice.exe has not been added to the Exception List for 
Microsoft Windows Firewall on the SmartPlant License Manager license machine, a 
blank tag list can display. 

 If you are using the PDS product, the domain name is not used when logging product 
usage. 

3. Select your license machine name that automatically appears in the License machine field 
or select it from the drop-down list. 

4. Select Batch or Interactive. To execute this option as a batch process, click the Batch 
option. The Time (Min) and Product Tag fields activate. Type the wait time in minutes. 

5. Click the Product tag drop-down list and select the product tag. 
6. Click OK. 
The SmartPlant License Manager Information dialog box appears. If you are testing 
client-license machine communication, note the seat number in the dialog box. The seat number 
information will be used in the Test Seat Release command. 

See Also 
Select a License Machine for a Client (on page 39) 
Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Select License Machine for Client (Current User) (on page 45) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Release (Current User) (on page 49) 
 

Test Seat Release - Current User 
Use the following procedure to ensure that a seat has been unreserved or released from the 
license machine. 
1. Click Test Seat Release on the Configuration and Testing dialog box. 

 
2. If the node name does not automatically appear in the License machine name field, select 

it from the list or type the node name in the License machine name field. Type the 
assigned number of the seat in the Seat Number field. 

3. Click OK. 
The SmartPlant License Manager Information dialog box appears with confirmation or error 
information. 

See Also 
Select a License Machine for a Client (on page 39) 
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Remove License Machine for a Client (on page 40) 
Display and Modify License Usage (on page 41) 
Test Seat Reservation (on page 42) 
Test Seat Release (on page 44) 
Select License Machine for Client (Current User) (on page 45) 
Remove License Machine for Client (Current User) (on page 46) 
Test Seat Reservation (Current User) (on page 47) 
 

Display Options Commands 
The Display Options commands display information in the SmartPlant License Information 
dialog box. In some fields on that dialog box, product abbreviations are used instead of the full 
product names.  Connect to the Intergraph eCustomer web site (https://crmweb.intergraph.com) 
to view the latest SmartPlant License Manager list of available product tags. 

   
 License machines with a high volume of network traffic, including seat requests and seat 

returns, should split the licenses onto multiple machines for  better licensing performance. 
 If you are using the PDS product, the domain name is not used when logging product 

usage. 
Use the following procedure to access the SmartPlant License Manager monitoring functions. 
1. Click Display on the main SmartPlant License Manager dialog box.  The Display 

Options dialog box appears. 

 

See Also 
Generate an Audit Code (on page 53) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
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Display the License Machine for Client - All Users 
Use the following procedure to display the list of license machines for a client and includes all 
users. 
1. Click Display License Machine for Client - All Users on the Display Options dialog box. 
The SmartPlant License Information dialog box appears. 

See Also 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
 

Display the License Machine for Client - Current User Only 
Use the following procedure to display the list of license machines for a client including only 
current users. 

 
 A license machine that is defined in the HK_Current_User does not roll over to a license 

machine defined using the SmartPlant License Manager interface (saved in 
HKLM_Current_User). 

 SmartPlant License Manager allows setting the license machine for each user account. 
Using the local administrator’s login, this can be defined at the registry key for the current 
user.  For example, 
[HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines]. 

 The SmartPlant License Manager license machine value displayed when Select License 
Machine for Client - Current User is selected is stored in 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry. If 
there is no SmartPlant License Manager license machine defined for the current user when 
you click Remove License Machine for Client - Current User, the following message 
displays:   
There are no license machines to display for this user under HKCU. 

When the SmartPlant License Manager client software finds a license machine listed in the 
correct registry location for the current user, the license machine listed will silently take 
precedence over the Selected License Machine for Client configured in the SmartPlant 
License Manager software.  
To determine if a custom license machine has been configured for a given client, login as that 
client and select Display > Display License Machine for Client - Current User Only. 
1. Click Display License Machine for Client - Current User Only on the Display Options 

dialog box. 
The SmartPlant License Information dialog box appears. 

See Also 
Configure a License Machine for Current User (on page 100) 
Display Options (on page 52) 
Display the Status of Active Daily Licenses (on page 54) 
Display the Status of Reserved Licenses (on page 54) 
Display the Status of Expired and Unexpired Keys (on page 54) 
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S E C T I O N  5  

Refer to the SmartPlant License Manager FAQ on the Web in the eCustomer system for the 
most current FAQ.  It is continually updated. Click 
https://crmweb.intergraph.com/ecustomer_enu and select Services > Download Software 
Updates > Products > SPLM. 
Will providing the Machine ID make my computer less secure? 

No. The Machine ID allows the license manager to uniquely identify your computer from a 
collection of hardware and software identifiers without explicitly publishing your computer's 
TCPIP address. Because the computer identifier cannot be used like a TCPIP address, it is 
actually more secure than publishing your computer's TCPIP address. 

Where can I find SmartPlant License Manager and other products to download? 
SmartPlant License Manager is available from the following web page:  
https://crmweb.intergraph.com 
Select Services > Download Software Updates > Products > SPLM. 
You do not need a serial number to install SmartPlant License Manager. 

Can I divide the licenses for one LAN into several license computers for the purpose of 
managing project access, for example, or as coverage in the event that my license 
computer goes down? 

Yes, you can divide the licenses.  
What happens if I install the new license key prior to expiration of the old license key? 

The new license will overwrite the existing key independent of the expiration date. 
Is my existing key still running if I regenerate the Machine ID? 

Yes, but you will not be able to reinstall the old key. You will need to request a new key for 
the new machine identifier. 

See Also 
Purchasing Licenses FAQ (on page 75) 
General Topics FAQ (on page 76) 
PDS, FrameWorks Plus, and ISOGEN FAQ (on page 77) 
 

Purchasing Licenses FAQ 
Do I have to request a software upgrade from my local office before requesting a license?   

No, you can request licenses without upgrading the software. If you are upgrading software, 
you must request the upgrade before you request licenses. A license request does not 
include a software upgrade and a software upgrade does not include a license request.  

See Also 
Frequently Asked Questions (FAQ) (on page 75) 
General Topics FAQ (on page 76) 
PDS, FrameWorks Plus, and ISOGEN FAQ (on page 77) 

Frequently Asked Questions (FAQ) 
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General Topics FAQ 
What is a license machine?  

The license machine is the computer where the license key is loaded; it can be a standard 
computer or a server. The license key tells the license machine how many licenses it can 
issue. Clients of a license machine are computers where SmartPlant License Manager is 
installed and pointing to the license machine. The computer where you start the software 
(for example, PDS or SmartPlant P&ID) asks the license machine for a license. If a license 
is available, the license machine provides it. If all licenses are in use, the client is not 
granted a license.  

How can I tell what version of SPLM was used in the Machine ID or license key file? 
Please check the starting number in your Machine ID or license key. See the table below. 

Version Machine ID starts with License key starts with 

2012 (v12) 5 3 

2010 (v11) 
 

6 2 

2008 (v10) 7 1 

Do I have to have one license computer for each LAN? 
No, your configuration is entirely up to you. A persistent network connection is required if 
you want to connect to a license server that belongs to a different LAN. 

Can I make an educated guess at my installation date?  
Yes. Intergraph provides a key within 48 hours of receipt of your request (via mail or phone). 
Please ensure that the date you request is the actual date that you install the key, making 
sure that all necessary software is available and loaded before that date. We request that 
you notify us as early as possible. 

What happens if my license machine goes down? 
You are unable to check out licenses from this machine until it is back in use. Processes 
that already have licenses checked out are not affected by the fact that the license computer 
is unavailable. 
It is possible in critical situations to request emergency licenses from Intergraph. They are 
installed on the client computer rather than a licensing machine. Contact Intergraph Support 
at 1-800-766-7701 or your local Intergraph office for more information. 

What happens if the license machine is rebooted in the middle of my design session? 
Nothing. Licensing does not depend on maintaining a continuous communication link to the 
license computer. 

What happens if my local computer goes down after I've obtained a license? 
If the scavenger cannot contact the client computer during scavenging, the license is 
marked for a 16-hour hold before it is released. The scavenger periodically advances this 
16-hour timer for each license. It is important to schedule the scavenger to run regularly, at 
least every hour or two. If the client is in contact sooner, the hold is voided and normal 
scavenging takes over. 

I am running out of licenses earlier than I believe I should be. How can I troubleshoot to 
understand what is happening? 
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Have your users click Scavenge for Keys on the Scavenge Options dialog box or you can 
type pdlice -n in a Command Prompt window.  
If you think that client nodes are improperly holding onto licenses, examine the results of the 
pdlice -M command. This shows you which client nodes have licenses checked out. If a 
client computer has no plant design-related activity and it is still holding licenses, rebooting 
that client and then scavenging from the license computer may free some licenses. 
If possible, find out what was processing when the job stopped. This information can help 
you and/or Intergraph determine the underlying cause of the termination. Save the output of 
any scavenging process that returns a license. This information provides the reasons why 
the license was returned. The output of the scavenger includes the following information: 
nodename, product tag, batch mode (Yes/No), process ID, and checkout time. 

What do I type to see the number of licenses? 
Click Show Key Status from the Display Options dialog box to show the status of your 
keys. 

How can I tell who is using a license? 
Click Display Status of Reserved License on the Display Options dialog box or in the 
license log file. 

We installed a key for three licenses, but we can operate only two licenses at the same 
time. Why? 

There can be several reasons. 
Click Display Status of Reserved License on the Display Options dialog box to 
determine the number of licenses that your key contains.  
Click Scavenge for Keys on the Scavenge Options dialog box to scavenge for the third 
license that you are unable to use. 
Verify that clients and servers can telnet to each other. Look for anomalies such as two 
nodes on the network with the same name or the reuse of an old name for a new computer, 
but with some traces of the old computer still existing in files on the network. 

When an application is on a computer that is disconnected from the network without 
exiting the product, how long is the license held?  

16 hours. 
How long would a daily license last? 

Daily license expires after 12 hours. 

See Also 
Frequently Asked Questions (FAQ) (on page 75) 
Purchasing Licenses FAQ (on page 75) 
PDS, FrameWorks Plus, and ISOGEN FAQ (on page 77) 
 

PDS, FrameWorks Plus, and ISOGEN FAQ 
How many licenses are recommended as a minimum for each operator (user) to work 
interactively as well as to start batch processes such as isometrics, reports, model 
creations, and so forth? 

There is no standard recommendation. If you are working in interactive mode only, then you 
only need one license. If you often run batch jobs while also working interactively, then you 
need two or more (although batch jobs can be scheduled to occur during off hours). Look 
closely at the site workflow to determine whether different formulas may be required within a 
customer site for different departments. For example, in a piping department where 
designers only are considered, the workflow requires four licenses for every three people. 
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How are ISOGEN licenses handled? 
SmartPlant License Manager requires the use of a license to run ISOGEN, a third-party 
product. Interactive isometric generation uses one Interactive ISOGEN license, while batch 
isometric generation uses one Batch ISOGEN license and one PDS 3D license.  

How are batch jobs handled? 
Batch jobs request one or more licenses at the time they are scheduled to run. If a license is 
not immediately available, the jobs wait until a license is available, and then the jobs start.  

Will an ISOGEN batch job take an interactive license? 
No. The batch job will not take an interactive license and an interactive job will not take a 
batch license. 

What is required to extract an Isometric drawing? 
Extracting an isometric drawing requires either an SBISO or SIISO license in addition to a 
3D license. The 3D license is required for the batch job. That is in addition to the Interactive 
3D seat required if the form is not returned to PD_Shell. 

What do I type to see the number of remaining PDS daily keys? 
Click Display Status of Active Daily Licenses on the Display Options dialog box to show 
the number of your remaining daily keys. 

How can I save a weekly record of PDS daily keys? 
You can save the output from the auditing process.  
Click Display Status of Active Daily Licenses on the Display Options dialog box to show 
the number of your remaining PDS daily keys. Click Save to display the Save File dialog 
box. Select a folder and file name to save the information to a file that you can use for later 
reference. Click OK to save the file. 

I expect PD_ISO to release a license as soon as the .idf file is generated, but this does not 
seem to be the case. Why not? 

Batch isometric generation uses a PDS license from the time the batch job first starts pdsidf 
until the project database has been updated for the last line in a batch job. PDS is working 
until the last line has been processed. In addition, a batch isometric generation uses a Batch 
ISOGEN license.  
Refer to the PDS ISOGEN Reference Guide for a basic description of the processes 
involved during a batch isometric run. 

I purchased PDS, but I am not on maintenance and need to move my key to a new TCP/IP 
address. Since I cannot access the eCustomer Web site, how do I get the SmartPlant 
License Manager software? 

Call Intergraph Support at 1-800-766-7701 or the local Intergraph office. For U.S. 
customers, Huntsville Support will provide the software via e-mail or the Intergraph external 
ftp site. For international customers, the local Intergraph office can download SmartPlant 
License Manager from eCustomer Web site and provide it to customers. 

My company purchased copies of FrameWorks Plus Standalone in addition to the PDS 
licenses that we purchased. When I enter FrameWorks Plus through PD_Shell, a PDS 
license is used. Why? 

When you access any module or product through PD_Shell, you are using it as a PDS 
module and thus a PDS license is used.  

Working interactively in ISOGEN requires one license. Is it possible to start batch 
processes for a single workstation with one license? 

You can schedule batch processes to run when the interactive license is not being used. 
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Is it possible to have purchased and leased licenses served from only one license 
machine? 

Yes. The licensing software does not differentiate between leased or purchased licenses. It 
only considers what is executing on the LAN. 

My PDS PID Standalone licenses are never used. Why? 
Verify that your PDS PID Standalone product was installed using your PDS PID Standalone 
serial number.  

Do you support a PDS Batch job on a Citrix machine with SPLM client installed? 
No, we don’t support running a PDS batch job on Citrix machine. It could result in a SPLM 
failed error. 

See Also 
Frequently Asked Questions (FAQ) (on page 75) 
Purchasing Licenses FAQ (on page 75) 
General Topics FAQ (on page 76) 
 

SmartSketch and SmartPlant Products FAQ 
What is the first release of SmartSketch that requires SmartPlant License Manager? 

Some installations of SmartSketch 5.0/SP1 require SmartPlant Licensing Manager, but not 
all of them.  Check with your System Administrator or contact Intergraph if you are not sure 
about installation.  

Which versions of SmartPlant Electrical and SmartPlant Instrumentation (formerly 
INtools) use SmartPlant License Manager? 

All versions of SmartPlant Electrical and SmartPlant Instrumentation versions 7 and higher 
use the SmartPlant License manager. Use the SmartPlant license request form to request 
license keys for SmartPlant Instrumentation versions 7 and higher, not the INtools license 
request form. 

Can SmartPlant Review 5.0 or later still be used on a laptop with SmartPlant License 
Manager?  Can SmartSketch 5.0?  

Yes. Install SmartPlant License Manager on the laptop and use the laptop as the license 
machine. You must request a license key for the laptop.  

When SmartPlant Instrumentation or INtools is on a machine that is disconnected from 
the network without exiting the product, how long is the license held?  

16 hours. 
 
 

SmartPlant 3D and SmartPlant Layout FAQ 
What functions take a SmartPlant 3D seat? 

Each SmartPlant 3D tasks (each instance of the S3Dhost.exe process) take one SmartPlant 
3D seat. Note that when doing a Paste/Restore operation, you open two SmartPlant 3D 
processes, and therefore this operation takes two SmartPlant 3D seats. In addition, three 
functions take a separate additional seat: SmartPlant 3D Interference Detection Service 
(Interference Checking), Batch Server, and Global Workshare Duplication and 
Synchronization service. 
For SmartPlant 3D version 2009.1 and later, Global Workshare DuSS service no longer 
requires its own SmartPlant 3D seat.  Additionally, the Remote IFC Process (Interference 
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Checking) no longer requires a seat for each model within a site.  Only one seat is pulled 
for the IFC service for the site. 

What about SmartPlant Layout? 
To use SmartPlant Layout, you must start SmartPlant 3D first. This takes one SmartPlant 
3D seat and one SmartPlant Layout seat. This matches what you get when you purchase 
one license of SmartPlant Layout, you get one seat of SmartPlant 3D and one seat of 
SmartPlant Layout. 

Are there other activities in SmartPlant 3D seat that require a special seat? 
The only other activity that requires a different seat is importing XML files (that came from 
PDS export, or from other systems) into SmartPlant 3D. This requires a SP3D Import seat. 

Can SmartPlant 3D and SmartPlant Layout work with any version of SPLM? 
No. Both products only work with version 9.0 (and future versions) of SPLM. 

If all my SmartPlant 3D seats are already in use, can a new instance of SP3D use another 
type of seat? 

No. SmartPlant 3D only works with a SP3D seat. 

See Also 
Frequently Asked Questions (FAQ) (on page 75) 
Purchasing Licenses FAQ (on page 75) 
General Topics FAQ (on page 76) 
PDS, FrameWorks Plus, and ISOGEN FAQ (on page 77) 
 

SmartPlant Reference Data and SmartPlant Materials 
FAQ 

Which SmartPlant License Manager License modules of SmartPlant Reference 
Data/SmartPlant Materials are supported? 

Current supported SmartPlant License Manager license modules are SmartPlant Reference 
Data and SmartPlant Materials. Support for smaller SmartPlant Reference Data/SmartPlant 
Materials parts like SmartPlant Materials Material Supply Chain Management, SmartPlant 
Materials Supplier Module, and so forth is planned for future implementation. 

Does SmartPlant Reference Data/SmartPlant Materials requires a permanent online 
connection with SmartPlant License Manager license machine? 

SmartPlant Reference Data/SmartPlant Materials is using the Checkout Utility which will be 
used to install a license key into the SmartPlant Reference Data/SmartPlant Materials 
database. After this installation, SmartPlant Reference Data/SmartPlant Materials can be 
operated without an online connection to SmartPlant License Manager license machine. 

Does SmartPlant Reference Data/SmartPlant Materials support SmartPlant License 
Manager? 

Yes 

SmartPlant Materials and SmartPlant Reference Data License Handling with SPLM 
SmartPlant License Manager (SPLM) provides license control for SmartPlant Materials (SPMat) 
and SmartPlant Reference Data (SPRD). This section explains the architecture and process for 
using SmartPlant License Manager. 
Architecture 
The following graphic displays how the SmartPlant License Manager license machine and 
SmartPlant Materials servers are configured and installed.  
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To the left of the dotted line, you can see the typical deployment of SmartPlant License 
Manager.  On right hand side of the dotted line, you can see the deployment of SmartPlant 
Materials. (This could be SmartPlant Materials or SmartPlant Reference Data or both). 

 
Here are some important points to remember: 
 The SmartPlant License Manager license machine interfaces with the SmartPlant 

Materials/SmartPlant Reference Data web application server, which connects to the 
database server. 

 The SmartPlant License Manager client is installed on the SmartPlant Materials/SmartPlant 
Reference Data web application server. 

 The existing mechanism for license management in SmartPlant Materials/SmartPlant 
Reference Data is used in this architecture. 

Prerequisites  
 The application server, database server, and SmartPlant License Manager license machine 

must be nodes within the same network domain.  
 SmartPlant Materials version 7.0.x is tested for SmartPlant License Manager version 10 and 

11.  
 Check if the installation of SmartPlant Materials hotfix JTS# TR-MA11323 is needed. For 

more information, see the Technical Users Forum at 
http://userforums.intergraph.com/materialstuf/.  

Installation of SPLM 
 For information about SmartPlant License Manager installation, please refer to Installation of 

SmartPlant License Manager and License Key Requests for the License Machine in this 
SmartPlant License Manager Installation and User’s Guide. 

Process 
Using the SmartPlant License Manager functionality, you (an administrator) get and install the 
license for SmartPlant Materials/SmartPlant Reference Data. You can then work in the 
SmartPlant Materials/SmartPlant Reference Data software. 
When the license is no longer needed, you can return the license to SmartPlant License 
Manager. 
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User Interface 
On the A.60.81 License screen (Install Through SPLM tab), fill in the fields. All fields are 
mandatory; this data is used to create the license. 

 
Customer Number: Enter 90001. 
Start Date (via LOV F9): License start date including all modules. 
End Date (via LOV F9): License end date (expiration date). 
Options: License installation option; depends upon how the database is configured. 
DEF means default; that is, the database is on a single database node. 

 Cluster options are not yet implemented (FS - Fail Safe, RAC - Real Application Cluster, 
DG - Data Guard). 
In the Modules block, enter the number of seats in the No of Seats field, and select the 
expiration date from the LOV in the Expires field for each relevant module. The available 
modules are listed below. 

SmartPlant Materials Module SmartPlant License Manager 
(SPLM) Tag 

Description 

SPMAT MAT Complete SmartPlant Materials 

E&PI MEP Engineering & Procurement Interface 
BOM and Requisition 

Integrator MIM Integrator 

MLCL MLC Material Life Cycle Library 
(Standardization) 
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MSCM MSC Material Supply Chain Management 
(Procurement) 

SITE MSM Site (Construction) 

MSCM-SUPP MSU E-Supplier module 

SPRD RD Complete SmartPlant Reference Data 

After filling out the fields, click the Request License button at the bottom. 

 
The following algorithm is used to install the license utilizing the SmartPlant License Manager 
license machine. 
 If a license is already installed, the software warns the user. 
 The software validates the input. This process validates that all required fields are supplied 

and additionally: 
 Total number of seats is greater than or equal to the sum of the seats mentioned for 

individual modules. 
 License start date cannot be previous date, and license end date is later than or the 

same as the start date. 
 The expiration date of each individual module is within the range of the license start 

date and end date. 
 At least one of the modules is checked for license generation. 

 The software installs the license: This step follows all the existing required procedures for 
license text generation and installation up to feedback generation and installing the 
confirmation code. 

 The software displays the internal license information in the License Text box. 
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Return License: Returns all the seats booked for all the modules back to the SmartPlant 
License Manager license machine for future usage. 

 
FAQ 
Question: If licenses that are currently checked out to SmartPlant Materials are due to expire in 
the next few days, can you have a new license key on the SmartPlant License Manager license 
machine while all current licenses are with SmartPlant Materials? Is it necessary for SmartPlant 
Materials to release back all checked out licenses (that are due to expire in the next few days) to 
the SmartPlant License Manager license machine for the SmartPlant License Manager license 
machine to have a new license/key (increased or decreased count)? 
Answer: From the SmartPlant Materials point of view – since the license is already checked out, 
it does not care what happens on the SmartPlant License Manager license machine. So you can 
change the SmartPlant License Manager key without affecting SmartPlant Materials. Then, in a 
few days, when the SmartPlant Materials license expires, simply check out a new license from 
the currently existing SmartPlant License Manager. 
So yes, you can have a new SmartPlant License Manager key installed on the SmartPlant 
License Manager license machine, and it is not required for SmartPlant Materials to release 
back all checked out licenses to the SmartPlant License Manager license machine for the 
SmartPlant License Manager license machine to have a new key installed. 
If you have un-returned seats and it's not expired yet from the old key, and you have a new key 
installed, you will not be able to use the new seat until the old checked out seat expires. 
Question: Does it matter if the new key being installed on the SmartPlant License Manager 
license machine has more or less seats when SmartPlant Materials is using currently checked 
out licenses? 
Answer: SmartPlant Materials does not care if the new key has more or less seat counts on the 
SmartPlant License Manager license machine. 
(This is different with PDS and all other SmartPlant products in which the SmartPlant License 
Manager license machine does care if less counts are in the new key while the old key has 
users using seats when you are installing it). 
Troubleshooting 
In case of failure during license installation, check the following: 
All servers are configured and installed and are available in the same domain as described in 
the Architecture section of this document. 
Check that the SmartPlant License Manager client can connect to the SmartPlant License 
Manager license machine. 
If license installation fails, search for the files splm_req_results.log and splm_ret_results.log on 
the SmartPlant Materials application server and send them to MSC for further support. 

MAR-10301: SPLM Interface is not available 
This error means that the OLE component that integrates SmartPlant Materials with SmartPlant 
License Manager is either not installed or not registered on the machine acting as application 
server for SmartPlant Materials. Go to the home directory of SmartPlant Materials on the 
application server and check the following path: \bin\SPLM. You must find MarianSplmInte.exe 
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in this folder. If it is not there, then it is an installation problem and installation has to be carried 
out properly again. If it is there, then probably it is not registered and you need to register this 
with the system registry. 

MAR-10302: Failed while preparing argument list for SPLM interface 
Normally this error will not come up. If this occurs, this is an environment-related problem and 
development will have to debug it in that case. 

MAR-10303: Failed while requesting for license to SPLM interface 
If installation of SmartPlant License Manager and SmartPlant Materials is done completely as 
mentioned earlier in this document, this problem will not come up. This error means that the call 
to the SmartPlant License Manager library functions failed. Check for pdliceo.lib in the system. 

MAR-10304: Failed while receiving GUID from SPLM interface 
There is a problem with the license installed. The SmartPlant License Manager client and 
license machine are not installed properly. 

MAR-10305: Failed while receiving seat identification from SPLM interface 
SmartPlant License Manager did not return a seat identifier in response to the request to 
reserve the seat. This could mean either no seats allocated for the module in the license text or 
all seats are in use and reserved. Please check your license text and license usage on the 
SmartPlant License Manager license machine. 

MAR-10306: Failed while receiving response from SPLM interface 
Normally this error will not occur. If it does occur, it means that SmartPlant License Manager is 
not returning any message text in response to the request to reserve the seat. Basically, this 
failure will happen while retrieving message text coming back in response to a request made to 
the SmartPlant License Manager license machine. 

MAR-10115: SPLM is not configured for module <RD/MAT> or no seats available 
This will occur when there is no seat available for the module shown in the message text. 
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S E C T I O N  6  

Use the following forms for all software, including SmartPlant Instrumentation 7.0 and later. For 
INtools 6.0 and older, use the INtools 6.0 (and older) License Key Request form. The request 
forms are available on the following product Web pages. 

FrameWorks Plus, 
SDNF Import 

http://www.intergraph.com/products/ppm/structural/additional_information.aspx 
http://www.intergraph.com/products/ppm/structural/additional_information.aspx 

PDS 3D, PDS 2D, 
ISOGEN 

http://www.intergraph.com/products/ppm/pds/additional_information.aspx 
http://www.intergraph.com/products/ppm/pds/additional_information.aspx 

SmartMarine 3D http://www.intergraph.com/products/ppm/sm3d/additional_information.aspx 
http://www.intergraph.com/products/ppm/sm3d/additional_information.aspx 

SmartPlant 3D http://www.intergraph.com/products/ppm/smartplant/3d/Additional_Information.aspx 
http://www.intergraph.com/products/ppm/smartplant/3d/Additional_Information.aspx 

SmartPlant Electrical http://www.intergraph.com/products/ppm/smartplant/electrical/Additional_Informatio
n.aspx 
http://www.intergraph.com/products/ppm/smartplant/electrical/Additional_Informatio
n.aspx 

SmartPlant 
Instrumentation 
(formerly INtools) 

http://www.intergraph.com/products/ppm/smartplant/instrumentation/Additional_Info
rmation.aspx 
http://www.intergraph.com/products/ppm/smartplant/instrumentation/Additional_Info
rmation.aspx 

SmartPlant 
Isometrics 

http://www.intergraph.com/products/ppm/smartplant/isometrics/Additional-Informatio
n.aspx 

SmartPlant P&ID http://www.intergraph.com/products/ppm/smartplant/pid/Additional_Information.aspx 
http://www.intergraph.com/products/ppm/smartplant/pid/Additional_Information.aspx 

SmartPlant Review http://www.intergraph.com/products/ppm/smartplant/review/Additional_Information.a
spx 
http://www.intergraph.com/products/ppm/smartplant/review/Additional_Information.a
spx 

SmartPlant Spoolgen http://www.intergraph.com/products/ppm/smartplant/spoolgen/Additional_Informatio
n.aspx 

SmartSketch http://www.intergraph.com/products/ppm/smartsketch/Additional_Information.aspx 
http://www.intergraph.com/products/ppm/smartsketch/Additional_Information.aspx 

SupportModeler http://www.intergraph.com/products/ppm/pds/supportmodeler/additional_information
.aspx 
http://www.intergraph.com/products/ppm/pds/supportmodeler/additional_information
.aspx 

See Also 
License Key Requests for the License Machine (on page 16) 
Upgrades and License Keys (on page 15) 
Software Version Compatibility (on page 16) 

License Key Request Forms 

http://www.intergraph.com/products/ppm/structural/additional_information.aspx
http://www.intergraph.com/products/ppm/pds/additional_information.aspx
http://www.intergraph.com/products/ppm/sm3d/additional_information.aspx
http://www.intergraph.com/products/ppm/smartplant/3d/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/electrical/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/electrical/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/instrumentation/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/instrumentation/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/pid/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/review/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartplant/review/Additional_Information.aspx
http://www.intergraph.com/products/ppm/smartsketch/Additional_Information.aspx
http://www.intergraph.com/products/ppm/pds/supportmodeler/additional_information.aspx
http://www.intergraph.com/products/ppm/pds/supportmodeler/additional_information.aspx
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S E C T I O N  7  

Use the key-in commands to run SmartPlant License Manager in a Command Prompt window. 

See Also 
Alphabetical List of Key-in Commands (on page 89) 
Functional List of Key-in Commands (on page 92) 
 
 

Alphabetical List of Key-in Commands 
The following is an alphabetical list of commands that you can use in a Command Prompt 
window. 

   
 If you are using Microsoft Windows 7, Windows Server 2008 R2, Windows Server 2008, or 

Windows Vista, you must use administrative privileges in the Command Prompt window to 
run any of the following commands.  Select Start > Programs > Accessories.  Select and 
right-click Command Prompt.  Click Run as administrator. 

 If UAC is turned on, you must use administrative privileges in the Command Prompt window 
to run any of the following commands.  Select Start > Programs > Accessories.  Select 
and right-click Command Prompt.  Click Run as administrator.  This applies to both the 
SPLM client and server computers.  If you do not use administrative privileges, an Access 
is denied message displays. 
Command Alphabetical List Description 

pdlice -a Installs the SmartPlant License Manager license machine key. 
For example, type pdlice -a 12AABBBCCCEDEFHKIPQRS. 
You must have administrative privileges to use this command. 

pdlice -A Displays the SmartPlant License Manager version number.  
This command is available with SmartPlant License Manager 
2012 (v12) or later. 

pdlice -B Displays the status of expired and unexpired license keys.  
Administrative privileges are required to use this command. 

pdlice -c Removes the current license machine key. You must have 
administrative privileges to use this command.  License 
machine options are no longer available after using this 
command.  When you use the Generate Machine ID 
command, license machine options are again available. 

pdlice -e Generates an auditing code.  Administrative privileges are 
required to use this command. 

pdlice -f Displays the current status of the license key.  Administrative 
privileges are required to use this command. 

pdlice -h Displays an alphabetical list of available commands for 
SmartPlant License Manager. 

Key-in Commands Overview 
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Command Alphabetical List Description 

pdlice -H Displays an alphabetical list of available commands for 
SmartPlant License Manager. 

pdlice -I Install and start the SmartPlant License Manager service. 

pdlice -l C Displays a list of available license machines contained in 
HKEY_Current_User. 

pdlice -j Adds license machines and their addresses to the 
server_names file. For example, type pdlice -j server1 server2. 

pdlice -k Deletes license machines from the server_names file. For 
example, type pdlice -k server1 server2 ... 

pdlice -l Displays the server_names file. 

pdlice -L 
pdlice -L 0 <zero> 
pdlice -L 1 
 
pdlice -L 1 path\(filename) 

Displays current settings for usage logging.  Options include: 
Disables usage logging.  
Enables usage logging and sets a default file path.  The 
default path is C:\Documents and 
Settings\<username>\logging.txt 
Enables usage logging and you can define a specified path for 
the log file.  For example, pdlice -L 1 C:\Temp\logging.txt 

pdlice -m Displays the current status of any reserved license.  
Administrative privileges are required to use this command. 

pdlice -M Displays the current status of active PDS daily license.  
Administrative privileges are required to use this command. 

pdlice -n Scavenges or searches for licenses.  Administrative privileges 
are required to use this command. 

pdlice -N Defines scavenging time intervals, scavenging output file 
name, and maximum output file size.  Setting 0 <zero> as the 
time interval disables scavenging.  Setting 1 as the time 
interval enables scavenging. 

pdlice - Q Displays and allows you to modify the current license usage 
options.  You must have administrative privileges to use this 
command. 
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Command Alphabetical List Description 

pdlice -r Reserves a license. For example, 
pdlice -r A B C server_name 
where: 
A = Use i for interactive, b for batch, and n for non-concurrent 
license. 
B = Wait time in minutes when A is set to b (batch mode).  If 
there are no seats available for batch, SmartPlant License 
Manager waits the specified time and then tries again.  When 
A is set to i (interactive mode), any value will work.  When A 
is set to n (counted seat for non-concurrent license), the value 
must be set to 0 (zero). 
C = Product Tag.  For example, 3D. 
Example key-in:   
pdlice -r i 1 3D server1 
pdlice -r n 0 FDY SPLMserver 
The server_name argument is optional.  If no server name(s) 
is supplied, SmartPlant License Manager searches the 
server_names file.   -1 for the third argument allows for a 
default waiting time to be used. The default waiting time is 
currently 12 hours for batch jobs if all licenses have been 
taken. 
The pdlice -r n 0 non-concurrent-tag splm-server command is 
available with SmartPlant License Manager 2012 (v12) or 
later. 

pdlice -R Stop and remove the SmartPlant License Manager service. 

pdlice -u Unreserves a license. For example, 
pdlice -u Seat_number license_server 
Example key-in:  pdlice -u 8 server1 

pdlice -Z Provides a list of available product tags for the SmartPlant 
License Manager license machine (in other words, available 
product tags that are found in the license key).  For example, 
pdlice -Z LicenseMachineName 
This command is available with SmartPlant License Manager 
2012 (v12) or later. 

pdlice -? Displays an alphabetical list of available commands for 
SmartPlant License Manager. 

See Also 
Key-in Commands Overview (on page 89) 
Functional List of Key-in Commands (on page 92) 
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Functional List of Key-in Commands 
The following is a list of commands that you can use in a Command Prompt window. 

 
 If you are using Windows 7, Windows Server 2008 R2, Windows Server 2008, or Windows 

Vista, you must use administrative privileges in the Command Prompt window to run any of 
the following commands.  Select Start > Programs > Accessories.  Select and right-click 
Command Prompt.  Click Run as administrator. 

 If UAC is turned on, you must use administrative privileges in the Command Prompt window 
to run any of the following commands.  Select Start > Programs > Accessories.  Select 
and right-click Command Prompt.  Click Run as administrator.  This applies to both the 
SPLM client and server computers. If you do not use administrative privileges, an Access is 
denied message displays. 
Functional List Description Command 

Generates an auditing code.  Administrative privileges are 
required to use this command. 

pdlice -e 

Displays an alphabetical list of available commands for SmartPlant 
License Manager. 

pdlice -? 
pdlice -h 
pdlice -H 

Install and start the SmartPlant License Manager service. pdlice -I 

Displays a list of available license machines contained in 
HKEY_Current_User. 

pdlice -l C 

Displays the current status of the license key.  Administrative 
privileges are required to use this command. 

pdlice -f 

Displays the SmartPlant License Manager version number.  This 
command is available with SmartPlant License Manager 2012 
(v12) or later. 

pdlice -A 

Provides a list of available product tags for the SmartPlant License 
Manager license machine (in other words, available product tags 
that are found in the license key).  For example, 
pdlice -Z LicenseMachineName 
This command is available with SmartPlant License Manager 2012 
(v12) or later. 

pdlice -Z 

Displays and allows you to modify the current license usage 
options. You must have administrative privileges to use this 
command. 

pdlice -Q 

Stops and remove the SmartPlant License Manager service. pdlice -R 

Provides a list of available product tags for the SmartPlant License 
Manager license machine.  For example, 
pdlice -Z LicenseMachineName 

pdlice -Z 
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Reserves a license. For example, 
pdlice -r A B C server_name 
where: 
A = Use i for interactive, b for batch, and n for non-concurrent 
license. 
B = Wait time in minutes when A is set to b (batch mode).  If there 
are no seats available for batch, SmartPlant License Manager 
waits the specified time and then tries again.  When A is set to i 
(interactive mode), any value will work.  When A is set to n 
(counted seat for non-concurrent license), the value must be set to 
0 (zero). 
C = Product Tag.  For example, 3D. 
Example key-in:   
pdlice -r i 1 3D server1 
pdlice -r n 0 FDY SPLMserver 
The server_name argument is optional.  If no server name(s) is 
supplied, SmartPlant License Manager searches the 
server_names file.   -1 for the third argument allows for a default 
waiting time to be used. The default waiting time is currently 12 
hours for batch jobs if all licenses have been taken. 
The pdlice -r n 0 non-concurrent-tag splm-server command is 
available with SmartPlant License Manager 2012 (v12) or later. 

pdlice -r 

Scavenges or searches for licenses.  Administrative privileges are 
required to use this command. 

pdlice -n 

Defines scavenging time intervals, scavenging output file name, 
and maximum output file size.  Setting 0 <zero> as the time 
interval disables scavenging.  Setting 1 as the time interval 
enables scavenging. 

pdlice -N 

Displays current settings for usage logging.  Options include: 
Disables usage logging.  
Enables usage logging and sets a default file path.  The default 
path is C:\Documents and Settings\<username>\logging.txt 
Enables usage logging and you can define a specified path for the 
log file.  For example, pdlice -L 1 C:\Temp\logging.txt 

pdlice -L 
pdlice -L 0 
pdlice -L 1 
 
pdlice -L 1 path\(filename) 

Installs the SmartPlant License Manager license machine key. For 
example, type pdlice -a 12AABBBCCCEDEFHKIPQRS. You must 
have administrative privileges to use this command. 

pdlice -a 

Removes the current license machine key. You must have 
administrative privileges to use this command.  License machine 
options are no longer available after using this command.  When 
you use the Generate Machine ID command, license machine 
options are again available. 

pdlice -c 

Displays the Server_names file. pdlice -l 

Adds license machines and their addresses to the server_names 
file. For example, type pdlice -j server1 server2. 

pdlice -j 
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Deletes license machines from the server_names file. For 
example, type pdlice -k server1 server2. 

pdlice -k 

Displays the status of active PDS daily licenses.  Administrative 
privileges are required to use this command. 

pdlice -M 

Displays the status of all license keys (expired and unexpired).  
Administrative privileges are required to use this command. 

pdlice -B 

Displays the status of reserved licenses.  Administrative privileges 
are required to use this command. 

pdlice -m 

Unreserves a license. For example, 
pdlice -u Seat_number license_server 
Example key-in:  pdlice -u 8 server1 

pdlice -u 

See Also 
Key-in Commands Overview (on page 89) 
Alphabetical List of Key-in Commands (on page 89) 
 

The SmartPlant License Checkout utility (License Checkout Utility.exe) allows you to obtain 
licenses for SmartPlant products for use on a non-networked computer (for example, a remote 
laptop). Using this utility allows you to run SmartPlant products without a network connection to 
the license machine. Each user on a server can check out a license on that machine. 
When you check out a license, the license and expiration information are stored on your local 
machine, separate from other license and expiration information. Each time you start the product 
during the checkout period, a message displays the expiration date for the checked out license. 
When the checkout period for the license expires, the SmartPlant product attempts to request a 
license using SmartPlant License Manager the next time you start the product. For example, 
after the license expires at 11:59 PM on the expiration date, the next time you start the product, 
it attempts to access the SmartPlant License Manager license machine for base and module 
licenses prior to running. 

 
 You must install and configure SmartPlant License Manager before checking out a license. 
 You must have administrator privileges to check out a license or to run the product using a 

checked out license. 
 

Appendix A:  Using the SmartPlant 
License Checkout Utility 
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Install SmartPlant License Checkout Utility 
 Do not uninstall the version of the SmartPlant License Checkout Utility that is 

currently on your system if you (a) are installing a new product that includes SmartPlant License 
Checkout Utility v11, or (b) have other applications such as SmartPlant Review or SmartSketch 
loaded on your machine. 
The older version of the SmartPlant License Checkout Utility is needed to work with your 
currently-loaded application(s). See the Compatibility chart for information on application 
versions and their required version of the SmartPlant License Checkout Utility. 

Compatibility 
The table below lists the applications that require the SmartPlant License Checkout Utility as 
well as their corresponding required versions. 

Application Version SmartPlant License Checkout 
Utility Version 

SmartSketch 
2009.1_06.01.00.31 

SPLMCU v04.02.01.1200 

SmartSketch 
2009SP1_06.00.01.0008 

SPLMCU v04.02.00.1100 

  

SmartPlant Review 
2008.2_07.00.00.30 

SPLMCU v04.02.00.1073 

SmartPlant Review 
2008.1_07.00.00.23 

SPLMCU v04.02.00.1053 
 

SmartPlant Review 
2008_07.00.00.22 

SmartPlant Review 
2007.4_06.02.00.40 

SPLMCU v04.01.03.1124 
 

SmartPlant Review 
2007.3_06.02.00.34 

SmartPlant Review 
2007.2_06.02.00.27 

SmartPlant Review 
2007.1_06.02.00.23 

SPLMCU v04.01.03.1035 
 

SmartPlant Review 
06.02.00.11 

SmartPlant Review 
06.01.00.18 

SPLMCU v04.01.02.9000 
 

SmartPlant Review 
06.01.00.15 

SmartPlant Review 
06.01.00.07 
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Install the Utility 
1. Insert the product disc. If the installation does not start automatically, double-click setup.exe 

in the main folder. 
2. Click SmartPlant License Checkout Utility. 
3. Type your name and company name. 
4. Verify your name and company name, and then click Next. 
5. Click Display to read and accept the license agreement, and then click Yes. 

 You must have a PDF reader to view the license agreement.  
6. Specify the destination folder. 
7. Review your settings, and then click Next. 
8. Click Install to start the installation process. 
9. Click Finish. 

 
 You can uninstall the License Checkout utility at any time, even if you are currently running 

a product in remote license mode. 
 If you installed the latest version of the SmartPlant License Checkout Utility (v11), it is 

installed along with the older version you have: 
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A P P E N D I X  A  

Before you install any SmartPlant Enterprise software on a Citrix server, you must install and 
configure the Citrix software and the corresponding prerequisites on the server. Please refer to 
your Citrix documentation for more information about any prerequisites. 
To run SmartPlant software on a Citrix server, you must install the same prerequisite software 
that is required for the product to run on a desktop client system. Make sure that any patches or 
prerequisite software installations are matched to the operating system.  For example, a 64-bit 
operating system may require that some patches or products are also 64-bit.  All patches or 
products should be in accordance with administrative guidance. For more information about 
software prerequisites for SmartPlant Enterprise products, see the documentation delivered with 
the product. 

 
 Only SmartPlant License Manager client is supported on a Citrix machine. 
 The SmartPlant License Manager license machine does not support a NAT configuration on 

a Citrix machine. 
 Running batch jobs on the Citrix XENAPP 6 server is not supported. 
 If you are using Citrix, and crossing multiple time zones, the error message SPLM 

Failed:  Server/Client Timers Mismatch by 6+ Hours - <license server> can display.  To 
correct the error, adjust the Citrix server's Time Zone Redirection configuration to prevent it 
from using the client's local time zone for the Citrix session.  For more information, refer to 
the Citrix's Knowledge Base article Troubleshooting Client Time Zone Issues 
(http://support.citrix.com/article/CTX303498). 

 If you have the license machine defined under HK_Current_User for SmartPlant License 
Manager, you cannot use Test Seat Reservation and Test Seat Release (commands in the 
SmartPlant License Manager product) to test the licensing machines. Those test options are 
used to test for the licensing machine configured in the SmartPlant License Manager's 
registry key (value from HK_Local_Machine in Registry). 

Appendix B:  Citrix and SmartPlant 
Software 
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 A license machine that is defined in the HK_Current_User does not roll over to a license 
machine defined using the SmartPlant License Manager interface (saved in 
HKLM_Current_User). 

 
Additional information about certified Citrix versions is available on the SmartPlant Enterprise 
Product Compatibility Matrix on the Intergraph Process, Power & Marine eCustomer Web site. 
To view this matrix, browse to the following Web address, and type your eCustomer user name 
and password: https://crmweb.intergraph.com.  Click Download Software Updates > 
Products, and then click the PPM Compatibility Matrices link in the middle of the page. 

  To install software on a Citrix server, you must log on with an account that has 
administrator access. Use the Change User Mode Option to set the Terminal Server in the 
"Installation" mode. 
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Hardware Requirements 
Refer to your Citrix documentation for system hardware requirements for the Citrix server.  
SmartPlant License Manager has no special hardware requirements beyond those 
recommended for Windows. 

Configure the SmartPlant License Manager Client on Citrix Server 
SmartPlant License Manager listens for license requests on TCP port 807 (the port must be 
open), and returns seat information over a randomly selected port. For more information, refer to 
Appendix E:  Microsoft Windows Firewall and SmartPlant License Manager (on page 111). 

Installing and Configuring the Product 
Refer to Installation of SmartPlant License Manager (on page 19) for information about installing 
and configuring SmartPlant License Manager.  There are no special requirements for installing 
SmartPlant License Manager for use with Citrix.  Configuring and installing SmartPlant License 
Manager as a license machine on Citrix is not supported. 

Publishing SmartPlant Applications  
SmartPlant License Manager does not require any components to be published for user access.  
Administrative access to the SmartPlant License software can be accomplished by publishing 
the SmartPlant License Manager application in accordance with standard Citrix practices. Use 
the provided Start > Intergraph SmartPlant License Manager menu for SmartPlant License 
Manager as a guide for publishing the individual SmartPlant License Manager applications. 

Known Issues 
Configuring SmartPlant License Manager as a license machine on Citrix is not supported. 

See Also 
Configure a License Machine for Current User (on page 100) 
 

Supported Platforms 
 SmartPlant License Manager Version 11 or greater 
 SmartPlant License Manager Version 10  
 Citrix Presentation Server 4.5.1 64bit Enterprise Edition 
 Citrix Presentation Server 4.5.1 32bit Enterprise Edition 
 Citrix Presentation Server 4.5.1 64bit Advanced Edition 
 Citrix Presentation Server 4.5.1 32bit Advanced Edition 
 Citrix XENAPP 6 on Microsoft Windows Server 2008 R2 
 Microsoft Windows Server 2003 Standard Edition 
 Microsoft Windows Server 2003 R2 Standard Edition 
 Microsoft Windows Server 2003 R2 Standard Edition Service Pack 2 
 Microsoft Windows Server 2003 Standard X64 Edition Service Pack 2 
 Microsoft Windows Server 2003 R2 Enterprise X64 Edition Service  
 Microsoft Windows Server 2008 R2 Enterprise X64 Edition 
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Configure a License Machine for Current User 
SmartPlant License Manager allows a specific SPLM License Machine to be assigned for a 
specific user. 
Using the SmartPlant License Manager Display the License Machine for a Client - Current 
User Only command, a license machine can be defined in the registry key for a current user.  
When the SmartPlant License Manager client software finds a license machine listed in the 
correct registry location for the current user, the license machine listed will silently take 
precedence over the "Selected License Machine" configured in the SmartPlant License Manager 
client interface. 
To determine if the license machine has been configured for a given client, login as that client.  
With SmartPlant License Manager open, select Display > Display License Machine for Client 
- Current User Only. 

 

Registry Entry Information 
The following registry information is required. 
 SPLM License Machine defined for current user is stored in 

[HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines] 
 A local administrator’s login is needed to define a license machine for the current 

user.  
 Under the registry key HKCU\Software\Intergraph\SPLM\LicenseMachines, 

SmartPlant License Manager license machines are listed as "String Value" registry entries.  
Each registry entry represents a SmartPlant License Manager license machine.   

 In order to enforce a given search order, the Name for License Machine must be created 
alphanumerically in the intended search order. 

 
The Data component must be created as a "String Value".  The content of each SmartPlant 
License Manager registry entry is composed of two parts, the DNS name of the SmartPlant 
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License Manager license machine, and the SmartPlant License Manager license machines IP 
address.  These two values must be separated by a single space. 

Value name - This is any arbitrary name you choose (windows will place these in 
alphanumeric order, so choose accordingly). 
Value data - This is the SmartPlant License Manager license machines Hostname and 
IP-address (separated by a space). 

 

Configure SPLM License Machine for Current User on Citrix Machine 
SmartPlant License Manager license machines can be defined per user account by making the 
prescribed registry entries for each user account. 

 
 Only SPLM client is supported on Citrix machine. 
 SPLM client v11 needs to point to a SPLM v11 license machine. 

See Also 
Appendix B:  Citrix and SmartPlant Software (on page 97) 
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A P P E N D I X  B  

SmartPlant License Manager requires a static IP Address in the license machine.  In order for a 
standalone system (such as a laptop) to be used as a SmartPlant License Manager license 
machine, you need to install and configure a Microsoft Loopback Adapter. The following steps 
use Microsoft Windows 7 as an example and explain how to configure Microsoft Loopback 
Adapter and SmartPlant License Manager on a laptop. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
Step 6: Selecting a License Machine and Reserving a Seat (on page 107) 
 

Step 1: Installing Microsoft Loopback Adapter 
Installing Microsoft Loopback Adapter using Microsoft 
Windows 7 
1. Login in to your computer as Administrator. 
2. Click Start > Computer. 
3. Right-click and select Manage. 
4. Click Device Manager. You can also open Device Manager from the Control Panel. 
5. Click Action (on the menu bar). 
6. Select Add legacy hardware and then click Next. 
7. Select Install the hardware that I manually select from a list (Advanced) option.  
8. Click Next.  
9. Select Network adapters from the list of Common hardware types list.  
10. Click Next.  
11. Select Microsoft and Microsoft Loopback Adapter on the Select Network Adapter 

window.  
12. Click Next.  
13. Click Next on the wizard is ready to install your hardware window.  
14. Click Finish when the wizard completes the installation. 
For more information refer to the Microsoft Web site (http://support.microsoft.com/ 
(http://support.microsoft.com)). You can search for the following articles: How to install the 

Appendix C: Installing SmartPlant 
License Manager on a Standalone 
System 

http://support.microsoft.com/
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Microsoft Loopback Adapter in Windows XP and How To Install Microsoft Loopback Adapter in 
Windows 2000. 

 It is recommended that you now rename this adapter making it easier to recognize in the 
future.  Click Control Panel > Network Connections.  Then, right-click on the name of the 
adapter you created and select Rename.  Enter a name that is easy for you to recognize, for 
example, SPLM License LoopBack, or a similarly unique name. 

See Also 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
Step 6: Selecting a License Server and Reserving a Seat (see "Step 6: Selecting a License 
Machine and Reserving a Seat" on page 107) 
 

Step 2: Configuring Static IP Address for the 
Microsoft Loopback Adapter 

1. Log onto the computer using the Administrator account.  
2. Click Start > Control Panel.  
3. Open Network and Sharing Center.  
4. Click Change Adapter Settings. 
5. Right-click on the installed loopback adapter and select Properties.  
6. Select Internet Protocol Version 4 (TCP/IPv4).  
7. Select Properties. The Internet Protocol Version 4 (TCP/IPv4) Properties dialog box 

appears.  
8. Click Use the following IP address. 
9. Type in the loopback adapter's IP address (for example, 192.168.0.10).  
10. Type in the Subnet mask (for example, 255.255.255.0).  
11. Click OK to dismiss the Internet Protocol Version 4 Properties dialog box.  
12. Click OK to dismiss Loopback Adapter Properties. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
Step 6: Selecting a License Server and Reserving a Seat (see "Step 6: Selecting a License 
Machine and Reserving a Seat" on page 107) 
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Step 3: Configuring Advanced Settings for the 
Loopback Adapter 

This section explains how to move the Microsoft Loopback Adapter to the top of the list of 
network connections so the Machine Identifier will gather the information from the Loopback 
Adapter to generate the code. 
1. Click Start > Control Panel. 
2.  Double-click Network Connections. The Network Connections window displays. 
3. Select Advanced > Advanced Settings.  The Advanced Settings dialog box displays. 

The Adapters and Bindings setting displays a list of connections. These connections are 
listed in the order they are accessed by network services. 

4. Click to highlight the previously created Loopback Adapter. 
5. Click the up arrow to move the loopback adapter to the top of the list. 
6. Click OK to dismiss the Advanced Settings dialog box. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
Step 6: Selecting a License Server and Reserving a Seat (see "Step 6: Selecting a License 
Machine and Reserving a Seat" on page 107) 
 

Step 4: Installing SmartPlant License Manager and 
Generating a Machine ID 

The following describes installing SmartPlant License Manager software and then generating a 
machine ID for a standalone system. 
1. Log onto the computer using the Administrator account.   
2. Install SmartPlant License Manager from your SmartPlant License Manager installation 

media. Choose to install SmartPlant License Manager License Machine. 
3. After SmartPlant License Manager license machine is installed, click Start > Computer and 

right-click. 
4. Select Manage. 
5. Open Device Manager.  
6. Click View > Show Hidden Devices on the menu bar. 
7. Right click and disable all the network adapters EXCEPT Microsoft Loopback Adapter in 

the list. 
8. Select Start > All Programs > Intergraph SmartPlant License Manager > Generate 

Machine ID.  
9. Save your Machine ID as a text file on your laptop. For example, c:/MachineID.txt. 
10. After your Machine ID is created, you can enable your network adapters in Device Manager 

list. 
11. Email the Machine ID text file to Intergraph (PPMSERV@INTERGRAPH.COM) or your 

regional office to request a SPLM key.  
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12. Do NOT re-run the Generate Machine ID command after you have sent your machine ID to 
Intergraph. 

13. After you receive a license key from Intergraph, click Start > All Programs > Intergraph 
SmartPlant License Manager > SmartPlant License Manager.  

14. Select Install and Remove > Install License Key. 
15. Copy and paste your key. 
16. If you receive a Mismatching error from SmartPlant License Manger when starting your 

software or when testing seat reservation, you can open a DOS window on your laptop and 
enter pdlice –c, then follow all the steps from 3 above to start it over. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
Step 6: Selecting a License Server and Reserving a Seat (see "Step 6: Selecting a License 
Machine and Reserving a Seat" on page 107) 
 

Step 5: Adding pdlice.exe to Firewall Exception List 
In order for SmartPlant License Manager to work properly, pdlice.exe MUST be added on the 
Windows Firewall allowed programs list. Otherwise, you may not be able to get a  license and 
you may see [Connecting Socket] Connection Time Out error message in your scavenging 
log file.  

 After a new installation or upgrade of SmartPlant License Manager, you must remove 
pdlice.exe from your Firewall Exception list if it is there from a  previous SmartPlant License 
Manager installation, and re-add it to the Exception list. This will ensure the correct version of 
pdlice is selected. Otherwise, you may see the [Connecting Socket] Connection Time Out error 
message in your Scavenging log file. 
1. Click Start > Control Panel > Windows Firewall.  
2. Click on Allow a program or feature through Windows Firewall. 
3. Click Change Settings. 
4. Click Allow Another Program. 
5. Click Browse to find pdlice.exe (by default it is in c:\Win32app\ingr\splm\bin). 
6. Select pdlice.exe and then click Open. 
7. Click Add. 
8. Select SmartPlant License Manager on the Programs list. 
9. Select Domain, Home and Public options. 
10. Click OK. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 6: Selecting a License Server and Reserving a Seat (see "Step 6: Selecting a License 
Machine and Reserving a Seat" on page 107) 
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Step 6: Selecting a License Machine and Reserving a 
Seat 

Use the following to select a license machine and then test to be sure a seat can be reserved 
and released. 

  If the IP address for the loopback adapter is changed after you have installed a 
SmartPlant License Manager key, the key will no longer be valid and the Product Tag list in the 
Test Seat Reservation dialog box will be empty.  You need to generate a new machine ID and 
install a new key. 
1. Select Start > All Programs > Intergraph SmartPlant License Manager > SmartPlant 

License Manager.  
2. Select Configure and Test, then click Select.  
3. Click Select License Machine for Client, then click Select.  
4. Enter your machine's node name or loopback adapter’s IP address in the License machine 

field. 
5. Click OK.  
6. Select Test Seat Reservation, and then click Select.  
7. Select your license machine from the License machine drop-down list box.  
8. On the Test Seat Reservation dialog box, select either Interactive or Batch as a Mode 

option. 
9. Select your product tag from the Product tag drop-down list box, and then click OK.  
10. Make a note of the seat number reserved, and then click Close.  
11. Click Test Seat Release, and then click Select.  
12. Select your license machine in the License machine name field.  
13. In the Seat number field, enter the seat number. 
14. Click OK. The software releases your seat successfully. 
15. Now, you should be able to start your SmartPlant application. 

See Also 
Step 1: Installing Microsoft Loopback Adapter (on page 103) 
Step 2: Configuring Static IP Address for the Microsoft Loopback Adapter (on page 104) 
Step 3: Configuring Advanced Settings for the Loopback Adapter (on page 105) 
Step 4: Installing SmartPlant License Manager and Generating a Machine ID (on page 105) 
Step 5: Adding pdlice.exe to Firewall Exception List (on page 106) 
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A P P E N D I X  C  

The SmartPlant License Manager Reporting Utility (SPLMRU) creates license reports using the 
license transaction data maintained in journal files.  The reports display using Microsoft Access. 
This utility contains all the tools necessary to collect needed journal files and create a database 
that is used for reporting.  This database is then opened using Microsoft Access.  You can then 
work with the data and create the delivered (default) license usage reports and charts.  You can 
also create customized reports. 
The following is a list of some of the delivered charts and reports. 
 Use by Product and User 
 Use by Product group by Month 
 Use by User by Product group by Quarter 
 Use by User by Product group by Month 
 Use by User by Product group by Month Matrix 

  Only SmartPlant License Manager 2008 and later versions can be used to create license 
usage reports. 
For more information, refer to the SmartPlant License Manager Reporting Utility User's Guide 
delivered on the SmartPlant License Manager product CD-ROM. 
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A P P E N D I X  D  

SmartPlant License Manager utilizes Transmission Control Protocol (TCP) ports to pass license 
seats from the SmartPlant License Manager license machine(s) to the workstation(s). TCP port 
807 is required to be open and is utilized by the SmartPlant License Manager license machine 
to ‘listen’ for requests from the workstation(s) for a license seat. If a request is made, a random 
TCP port is utilized to pass the seat from license machine to client. 
Since a firewall is used to prevent unauthorized port access, SmartPlant License Manager has 
problems working properly with a firewall. Most firewall programs allow an Administrator to open 
ports to prevent the firewall from interfering with a programs execution. Because SmartPlant 
License Manager utilizes random ports, there is not a good way to do this unless the firewall 
program also allows programs to be added to a program list to open ports required by the 
program. 
If the user exits the application properly, the license used by the workstation is released back to 
the pool of licenses available. Sometimes, when an application process is exited abnormally, the 
license seat is not returned to the license manager. This is where the SmartPlant License 
Manager license machine can help. A scavenge routine can be setup to run that will scavenge 
the network for seats that are reserved. If one is found, the seat can be returned to the pool if it 
is no longer in use. The firewall prevents the license machine from retrieving the seat and 
returns a timed out error message. 

 In order to run commands using the Command Prompt window, pdlice.exe needs to be 
added to the Exception List for the Windows Firewall on both the license machine and the client 
machine (if it is turned on).  This includes all Windows operating system (for example, Microsoft 
Windows 7, Windows Server 2008 R2, Windows Server 2003, Windows XP, and so forth). The 
following steps provide an example of how to add the appropriate SmartPlant License Manager 
program to the Exception List for Microsoft Windows 7 (allowing for proper scavenging and 
access to the license machine). 
1. Select Start > Control Panel > Windows Firewall to display the Windows Firewall options. 
2. Click to select Allow a program or feature through Windows Firewall. 
3. Click Change settings. 
4. Click Allow another program. 
5. Click Browse on the Add a Program dialog box. 
6. Browse for the pdlice.exe program (by default it is installed in c:\win32app\ingr\splm\bin). 
7. Click to select pdlice.exe and click Open. 
8. Click Add on the Add a Program dialog box.  SmartPlant License Manager now displays in 

the Allowed programs and features list. 
9. Click OK to dismiss the Windows Firewall options. 

  [Connecting Socket] Connection Time Out is the error message you receive if 
pdlice.exe is not defined in the Windows Firewall exception list. 
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A P P E N D I X  E  

The following explains how to configure SmartPlant License Manager client using VMware.  
Only SmartPlant License Manager client is supported when using VMware.  Also included are 
instructions for pointing to the host machine (if it is configured as a license machine) or any 
other license machines on the network. These procedures use the VMware session in a 
Workgroup environment and not joined to any domain. 

VM Settings (Host Only) 
Using this option, the VMware session cannot access your network. You will need to set up your 
VMware host machine as the license machine (your VMware session can only pull a license 
from your host).  
Use the following steps to set up you host as a SmartPlant License Manager license machine. 
1. Install SPLM software on the host machine. 
2. Define a fixed IP address or install and setup Microsoft Loopback adapter if you are running 

on a laptop. 
3. Generate the Machine ID. 
4. Request a new license key (ppmserv@intergraph.com). 
5. Install the license key.  Refer to the SmartPlant License Manager document, Configuring 

SPLM on a Laptop, on eCustomer or the SmartPlant License Manager Help file topic 
Appendix C: Installing SmartPlant License Manager on a Standalone System for more 
details.  

On your host machine, use the following steps to verify your VM network adapters.  
1. Open Network Connections on your host. 
2. VMware adapters (VMnet1 and VMnet8, by default) must be enabled.  
3. The loopback adapter must be enabled if it is used to generate the license key.  If it is not 

enabled, a “TCP Mismatch …” error messages will display in SmartPlant License Manager.  

Appendix F:  Configure SmartPlant 
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4. You must enable these adapters or reboot the host machine.  

 
Use the following steps to set your VM as Host-Only.   
1. Start your VMware session.  
2. Click VM menu > Settings. 
3. Highlight Network Adapter and change network connection to Host-Only. 
4. Exit out your VMware session. 
5. Reboot your host machine. 
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6. Restart your VMware session. 
Use the following steps to install SmartPlant License Manager and retrieve a license. 
1. Install SmartPlant License Manager in the VMware session. 
2. Select SmartPlant License Manager > Configure and Test > Select License Machine for 

Client. 
3. Enter your host's name and click OK. 
4. Select Test Seat Reservation and select your host's name. 
5. If you can successfully reserve a license from your host, you can start your application in 

your VMware session. 
  If your VMware Network Adapter (VMnet1) is set for Host-Only in Virtual Network Editor, 

you will see the VMnet1 IP address when you add your host as license machine. 

VM Settings (Option 2: NAT (Network Address 
Translation) 

Using this option, your VMware session can access your network resources and it can retrieve 
licenses from either the host machine (connected or disconnected with a network) or other 
license machines on the network. 
1. Setup you host as a SmartPlant License Machine (optional) 

 See instructions above in option 1. 
 You may skip this step if you do not need to retrieve a license from your host machine.  

2. Check to confirm that your host is connected to the network. 
3. Check to confirm your network adapters are running on your host machine. 

 Open Network Connections on your host,  
 VMware adapters (VMnet1 and VMnet8 by default) must be enabled. 
 Loopback adapter should be enabled if it’s used to generate license key and you need 

to add it as a license machine. 
 If not, you need to enable them or reboot the host machine. 

4. Set VM setting to NAT. 
 Start your VMware session. 
 Click VM menu > Settings. 
 Network Adapter > NAT. 
 Exit out your VMware session. 
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 Reboot your host machine then restart your VMware session. 

 
5. Install SPLM software in the VMware session.  
6. Select licensing machine to get license: 

 Open SPLM > Configure and Test > Select License Server for Client, 
 Type in the node name of your licensing machine (your host or other licensing machine 

on your network) and click OK. 
 Test Seat Reservation  
 If you can successfully reserve a license from your licensing machine, you can now start 

your application in your VMware session.  
 
 If you are connected to your network, the 1st network adapter’s IP in your host’s 

network connection list (Advanced Settings) would be showing when you add your host 
machine as license machine.  

 If you are disconnected from your network, adding your host machine as license 
machine will pull the loopback adaptor’s IP.  

 You cannot add other license machines on the network if you are disconnected.  
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VM Settings (Option 3: Bridged)  
Using this option, you can have only one VMware session running on the network at the same 
time. You can add your host or other license machines on your network. 
1. Make sure your host is connected to the network.  
2. Make sure your network adapters are running on your host machine. 

 Your physical network adapter needs to be enabled 
 Loopback adapter needs to be enabled if it’s used to generate license key and you need 

to add it as license machine. 
 If not, you need to enable them or reboot the host machine. 

3. Change VM settings to Bridged. 
 Start your VMware session. 
 Click VM menu, select Settings. 
 Network Adapter > Bridged. 
 Exit out your VMware session. 
 Reboot your host machine then restart your VMware session. 

 
4. Make sure your VM has network connection. 

Note: You may need to reconfigure VMnet0 from "Bridged to an automatically chosen 
adapter" to your physical adapter in Virtual Network Editor, if your VM has no or limited 
network connection.  

5. Install SmartPlant License Manager software in the VMware session.  
6. Select license machine to get license. 
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 Open SPLM > Configure and Test > Select License Machine for Client. 
 Type in the node name of your license machine (your host or other license machine on 

your network) and click Ok. 
 Test Seat Reservation. 
 If you can successfully reserve a license from your license machine, you can now start 

your application in your VMware session.  
 Your host’s network IP will be used if you add your host as license machine. 
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A P P E N D I X  F  

The following provides a list of SmartPlant License Manager error messages with an explanation 
of each error.  Also, the Troubleshooting topic provides solutions to issues than can occur. 

See Also 
Error Messages (on page 120) 
Troubleshooting (on page 119) 
 

Troubleshooting 
Verify that the SmartPlant License Manager service is started 
1. Click Start > Settings > Control Panel > Administrative Tools > Services. 
2. In the Services dialog box, scroll down the list and verify that the SPLM - SmartPlant 

License Manager service has a status of Started and that Startup is set to Automatic. 

 

Installing and Starting the SmartPlant License Manager Service 
SmartPlant License Manager installs and starts the SmartPlant License Manager service during 
installation, so Administrators will not normally need to use this command. 
Use the following procedure to install and start the SmartPlant License Manager service. This 
command requires system administrator privileges. 
1. On the Install and Remove Options dialog box, click Install and Start Licensing Service. 

(Or, type pdlice –I in a Command Prompt window.) A message box confirms that the service 
has been installed and started. 

Verify that the registry keys have been created 
1. In a Command Prompt window, type regedt32. Several Registry windows appear.   

Appendix G:  Troubleshooting and 
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2. Select the HKEY_LOCAL_MACHINE window. 

 
3. Expand the SOFTWARE\Intergraph\PD_LICE\Current Version folder to display information 

about the current version of SmartPlant License Manager. 
4. Expand the SOFTWARE\Intergraph\Pdlice_etc folder. You should have a Server_names 

file. You may also have a pdlice_key_S file if it is a license machine. 

Stopping the SmartPlant License Manager Service 
In the rare instance when the SmartPlant License Manager executable stops running, you can 
restart it by stopping and restarting the SmartPlant License Manager service, Use the following 
procedure to stop the SmartPlant License Manager service. This command requires system 
administrator privileges. 
1. On the Install and Remove Options dialog box, click Stop and Remove Licensing 

Service. (Or, type pdlice –R in a Command Prompt window.) A message box appears to 
ensure that you want to remove the service. 

2. Click Yes to stop the licensing service on this computer. Click No to dismiss this dialog box 
and keep the licensing service running on the computer. If you click Yes, a message 
confirms that the licensing service is stopped. 

3. Restart the SmartPlant License Manager service as explained in Install and Start the 
Licensing Service (on page 36). 

License Timer is Newer Than License Machine System Clock 
This error indicates that SmartPlant License Manager will not work until the system clock time 
catches up to or passes the timestamp on the license file.  In other words, the system clock time 
has been moved forward in time.  When the system clock is returned to the correct time, 
SmartPlant License Manager stops and this error message displays.  To fix the error, you need 
to remove the license key.  Then, generate a new machine ID and request and install a new 
license key. 

See Also 
Error Messages (on page 120) 
 

Error Messages 
A problem has occurred with the machine identifier and a key cannot be generated.  
Error code = 1. 

A machine ID must be generated to get a new license key for use with SmartPlant License 
Manager Version 2010. 

A valid license key cannot be located on this machine 
This message displays when you try to reserve a license from a machine that has not been 
setup as a SmartPlant License Manager licensing computer. 

A valid license server cannot be located for this client 
This message displays when a client machine is pointing to another client machine as a 
license machine.  A valid license machine must be defined. 
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An invalid version of the machine identifier was entered.  Please generate a machine 
identifier for SPLM 2010. 

Indicates that a machine ID has been generated using SmartPlant License Manager 2008 or 
earlier release.  You need to install the latest version of SmartPlant License Manager. 

Another version of this product is already installed. Installation of this version cannot 
continue. To configure or remove the existing version of this product, use Add/Remove 
Programs on the Control Panel. 

SmartPlant License Manager installation will stop if another instance of SmartPlant License 
Manager or PD_Lice is currently installed.  Remove the currently installed version to 
continue. 

Cannot Receive Full Packet, Bad Network Packet; Check PDLICE (Cl/Srv) versions 
This message indicates a mismatch of SmartPlant License Manager versions. To check 
your current version of SmartPlant License Manager, click Help > About SmartPlant 
License Manager on the main dialog box. 

[Connection Socket] Cannot assign requested address 
This error indicates that SmartPlant License Manager client, while using VM, cannot find the 
license machine.  For example, when you have a bridged VM setting and you try to retrieve 
a license from the license machine on the network, but you are not connected to the 
network.  This error could also indicate that you connected to your network and 
successfully retrieving licenses, but your VM setting is Host-only.   
To fix the error in the first example, you need to successfully connect to your network.  To 
fix the error in the second example, you need to change your VM setting to bridged and 
reboot the VM client operating system. 

[Connecting Socket] Connection Refused 
Reserving licenses on clients or the license machine fails. The SmartPlant License 
Information message box displays the Connection refused message. Restarting the service 
on the license machine will solve the error. 

[Connecting Socket] Connection Time Out 
 The message displays if the pdlice.exe is not defined in the Windows Firewall exception 

list. To resolve the error, add pdlice.exe in the Windows Firewall's exception list in the 
client and the license machine if the OS is Windows XP SP2 or Windows 2003 SP1. 

 A SmartPlant License Manager client machine must have licensing service running on 
the machine for the license machine to scavenge for licenses.  If the license service is 
not running on the client machine, the license machine will not be able to scavenge 
seats.  This error displays in the Scavenge log file. 

 A slow network connection could also cause this error message to display. 
 If the license machine is not on or rebooting, this error message displays. 
 If the SmartPlant License Manager client machine is testing for reserving a seat, this 

message displays. 
 If a computer is added incorrectly to the license machine list, this message displays. 

Connection Reset by Peer 
Any of the following can cause Connection Reset by Peer error message to display. 
 This message displays if you have Panda Antipodes software installed on the machine. 
 Disable IMON module or uninstall NOD32 Antivirus if installed.  Select NOD32 Control 

Center > IMON > Quit > Reboot. 
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 Remove Acceleration module if Cingular or ATT Communication Manager is installed 
(Tools > Settings > Acceleration tab > Client: Uninstall and remove the software.  
Reboot the licensing machine.). 

 Remove EMBASSY® Trust Suite if installed. 
 Remove Vodafone™ Mobile Connect software if installed. 

Could not return the license to SmartPlant License Manager.  SPLM Failed: Failed to 
release seat 

If you are removing SmartPlant License Manager on a license machine where there are still 
licenses in use, this error message could display when users exit the client application.  
This is normal and the error should not occur once a new key is installed on the license 
machine. 

Could not set install date 
This message appears during the installation of SmartPlant License Manager. This problem 
has been reported on machines with German Microsoft Windows XP (SP2) and Microsoft 
Windows 2003 (SP1). To resolve the problem, reinstall the operating system's Service Pack. 

Error in OpenService for SPLM - SmartPlant License Manager.  This operation completed 
successfully. 

This error occurs when SmartPlant License Manager service is not installed and running. To 
install and start SmartPlant License Manager license service, start SmartPlant License 
Manager. Click Install and Remove > Install and Start Licensing Service. After you 
install and start the license service, you can then change the scavenging options. 

ftp server failing (looping), service terminated 
The inetd process is refusing your connection attempts. This indicates that the inetd daemon 
has too many connection requests. Requests are refused for 10 minutes. This can happen 
during scavenging or if too many clients are simultaneously requesting access. 
On the computer that is refusing the connection, stop the SmartPlant License Manager 
service. To stop the service, click Stop and Remove Licensing Service on the Install and 
Remove Options dialog box. To restart the licensing service, click Install and Start Licensing 
Service on the Install and Remove Options dialog box. 

Invalid Option for SPLM client. 
You need to select and run the Generate machine ID command first in order to run pdlice 
commands for the license machine options. 

Key request for file XXX contains more than 32766 seats.  Key cannot be generated for 
file XXXX. 

Indicates that the seat count has exceeded the maximum limit of 32,766. 
License File Time is newer than License Server System Clock 

SmartPlant License Manager will not work until the system clock time equals or passes the 
timestamp on the license file.  The changing of time zones will not have any impact on the 
way the software functions.  If you set the time back to the correct time and receive an error 
message, you will need to remove the key and generate a new machine ID.  Then, you 
must request and install a new key. 

License database locked by another user 
Exit the SmartPlant License Manager software after installing the license key.  This error 
message can also display if scavenging interferes with a new license request. 

[Opening File] - No such file or directory - /etc/file_name 
A license has not been installed or a license machine(s) is not known. Be sure the file name 
appears in one of these files: 
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/etc/pdlice/pdlice_key_S 
/etc/pdlice/pdlice_cfg_S 
/etc/pdlice/server_names 

OpenServiceControl Manager, the operation completed successfully. 
If you are using Windows 7, Windows Server 2008 R2, Windows Server 2008 or Windows 
Vista with UAC turned on, you may encounter this error when you are trying to stop or start 
SPLM licensing service or trying to use pdlice -I or pdlice -R. When you get this error, 
the SPLM licensing service was actually not stopped or started. You must log onto your 
machine with administrative privilege.  To do this, right-click SmartPlant License Manager 
and click Run As Administrator to open SmartPlant License Manager.  Or, right-click on 
Command Prompt and click Run As Administrator to open DOS window. 
 

PDLICE_PUT_SEAT error 
The license machine was booting or otherwise not responsive. Possibly, another process, 
for example scavenger, kept the licensing files locked at that instant. The scavenging 
process should free the license shortly. 
If you want to free the license sooner, type pdlice -n on the license machine. 
If you see this message while running PD_SHELL, exit PD_SHELL completely. If you do not 
exit and you execute another task, there will be two seats assigned to the same PD_SHELL 
process (new seat + old seat that is not released yet). 
To free the license sooner using a Microsoft Windows computer, click Scavenge for Keys 
on the Scavenge Options dialog box. 

<Product Tag Name> product tag is not part of new key and there are seats currently 
reserved. 

This message occurs when you are installing a new license key which does not have a valid 
product tag name seat but your existing license key does have valid product tag name seats 
being used.  Ask users to exit the product and then install your new license key. An 
example message is INS product tag is not part of new key and there are seats 
currently reserved.  

Product usage logs must be saved to a local drive 
The log file cannot be routed to a different machine.  The log file must be generated on the 
license machine. 

Run-time error '53':File not found 
The license machine has been upgraded and no new machine ID has been generated or a 
SPLM 2008 key has not been installed.  You must generate a new machine ID.  Then, 
request and install a SPLM 2008 key. 

Seat count is too low to transfer current reserved seats to new key 
Indicates the new key you are installing has fewer seats than the current key.  You can exit 
the application (possibly resulting in loss of seat usage) or create a batch command to install 
the new key at a later time.  Batch jobs can execute at night when the current key expires 
and everyone has exited the software. 

Server Key File Mismatch (?) - Remove & Reinstall 
The key files for the license machine are corrupt. You must re-install the key. Any corrupt 
code appears in parentheses. Call Intergraph Support (1-800-766-7701) to receive help with 
the corrupt code. You can still run all the Windows Display Options commands. 

SetupDLL\SetupDLL.cpp (391), pAPP:, pVENDOR:, PGUID:, $11.0.0.28844, @Windows XP 
Service Pack 2 (2600) IE6.0.2900.2180 
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This error message displays during installation of SmartPlant License Manager if you do not 
have full registry permission on HKEY_LOCAL_MACHINE\SOFTWARE\Intergraph key.  

SmartPlant License Manager registry entry is not available.  Processing terminated. 
This message indicates that the SmartPlant License Manager registry entry PD_LICE has 
been deleted.  You need to run SmartPlant License Manager setup.exe and select the 
Repair option to recreate PD_LICE registry. 

SmartPlant License Manager Warning: License expires within [days] - 20 
This message appears each time a license is allocated beginning 45 days before expiration. 
The example warning message used here indicates the license will expire in 20 days. Notify 
Intergraph to set an installation date for a new license. 

SPLM:  Adding License Machine(s) To server_names file... 
SPLM License Machines List File (Client) -> server_names 
[Opening File] Access is denied.  - SOFTWARE\Intergraph\Pdlice_etc 
SPLM License Machines:>  Node:  xxxxx  Address: xxx.xxx.xxx.x 

Indicates that a user without administrative privileges tries to select a license machine.  You 
must have administrative rights to use the Select License Machine for Client command.  

SPLM: Adding License Machine(s) To server_names File... 
SPLM License Machines List File (Client)  -> server_names 
SPLM Error: [Opening File] Access is denied. 
- SOFTWARE\Intergraph\Pdlice_etc 

If you are using Microsoft Windows 7, Windows Server 2008 R2, Windows Server 2008 or 
Windows Vista, you may encounter this error when you are trying to select a license 
machine or to use pdlice -j. You must log onto your machine with administrative 
privilege.  To do this, right-click SmartPlant License Manger then choose Run As 
Administrator to open SmartPlant License Manger.  Or, you can right-click Command 
Prompt then choose Run As Administrator to open DOS window. 

SPLM: Adding Server(s) To server_names File... 
SPLM Servers List File (Client)  -> server_names 
Node:          in-sp3dcert13.ingr.c 
Address:        0.0.0.0 
Status:        [In gethostbyname] No error 
Invalid Server Name.  License Server list was not modified. 
Displays when an incorrect server name is entered.  To resolve the error, type a valid 
server name. 

SPLM Error: There are no license machines to display under HKLM for this current user. 
If there is no SmartPlant License Manager license machine selected, running pdlice -l 
displays this message. You need to select a license machine for your client machine. 

SPLM:  Displaying Seats In Use .......... This is no key installed on this machine 
Indicates that no key has been installed on the machine.  You need to install a valid key. 

SPLM: Displaying SPLM Machines For This Current User... 
Displays the SPLM computers for the current licensed user. 

SPLM Error:  Another Scavenger Already Active; Retry 
Displays in the scavenging log file and indicates that you need to reset the scavenging time 
interval to a longer time.  This message may also display while manually running a 
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scavenge (if a scheduled scavenge is already in progress.)  Two scavenge processes can 
not run at the same time (manual or scheduled). 

SPLM Failed: A valid license file cannot be located on this machine 
You have not selected a licensing machine or defined an SPLM client machine.  Or, you 
have not installed a license key on the machine pointed to by the SPLM client. 

SPLM Failed: [Creating/Starting] Parameter incorrect  
Indicates that the program.exe is to Windows XP compatibility.  Remove the setting 
regardless of operating system being used. 

SPLM Failed:  No grade-level seat available - (product tag) 
Indicates that the license machine is out of the product seat(s) you are requesting (or does 
not have the license you are requesting).  Check your license machine seat usage. 

SPLM Failed: [Read Pipe] Garbled Data From SPLM (Client) 
The incorrect versions of software are installed. You must install the required versions of 
your product and SmartPlant License Manager. For example, you have installed PDS 8.0.1 
and SmartPlant License Manager 8.0 client (or earlier version). You must install the latest 
version of SmartPlant License Manager on the client. 

SPLM Failed: Invalid Key.  Mismatching parameters. 
The physical network adapter is disabled.  Enable your network adapter to correct the error.  
This error can also occur on a standalone system, such as a laptop used for a license 
machine.  To fix this, enable only the loopback adapter and disable all adapters, including 
VPN.  VPN is not a supported configuration for SmartPlant License Manager. You can 
disable all adapters from Control Panel > Network Connections, or you can disable it from 
the Device Manager.  Then run pdlice -c, generate a new machine ID, and request a new 
key. 

SPLM Failed: Invalid Network Request - <license server> 
The incorrect versions of software are installed. You must install the required versions of 
your product and SmartPlant License Manager. example, you have installed PDS 8.0.1 and 
SmartPlant License Manager 8.0 (or earlier version). You must install the latest version of 
SmartPlant License Manager on the license machine. 

SPLM Failed: LicenseMachineName 
If you have SmartPlant License Manger 2012 (v12) client installed and you are trying to get 
a license from SmartPlant License Manger 2008 (v10) license machine, this error displays. 
You need to remove the SmartPlant License Machine 2008 (v10) license machine and 
select a SmartPlant License Machine 2012 (v12) license machine. 

SPLM Failed:  License Machine Tcp Address Zero In Server_names File 
Occurs when you have SPLM_1 key defined in the 
HKEY_CURRENT_USER\Software\Intergraph\SPLM\LicenseMachines registry 
entry, but no license machine name and IP is defined in the SPLM_1 key (no string value). 
You need to either add data in the string value SPLM_1 or delete SPLM_1. Otherwise, you 
will not able to start your application.  

SPLM Failed:  License server is not defined for this client 
Indicates that the license machine is not defined on the client.  You need to define a license 
machine for the client.  Refer to Selecting a License Machine for a Client for more 
information. 

SPLM Failed:  [reading socket] connection reset by peer 
Indicates AT&T Communication Manager is installed on the SmartPlant License Manager 
licensing machine and displays when SmartPlant software is started or an attempt is made 
to reserve a seat. 
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To resolve the error, select AT&T Communication Manager > Tools > Settings > 
Acceleration tab > Client: Uninstall and remove the software.  Then, reboot the licensing 
machine.  You can install the Acceleration client in the AT&T Communication Manager if 
the machine is not the licensing machine. 

SPLM Failed:  [reading socket] Software caused connection abort. 
This message appears when you release a seat or close PDS when SmartPlant License 
Manager was removed at the license machine after you get a seat. 

SPLM Failed:  Seat No. has not been reserved: 54 
Indicates that a client machine has reserved a seat and then changed IP addresses while 
SmartPlant License Manager is running.  This message is seen when exiting the software. 

SPLM Failed:  Server/Client Timers Mismatch by 6+ Hours - <license server> 
Indicates that the license machine times are not synchronized.  You must match the client 
clock time to be within a 6-hour range of the SmartPlant License Manager license machine 
clock time. 
If you are using Citrix, and crossing multiple time zones, this error can display.  To correct 
the error, adjust the Citrix server's Time Zone Redirection configuration to prevent it from 
using the client's local time zone for the Citrix session.  For more information, refer to the 
Citrix's Knowledge Base article Troubleshooting Client Time Zone Issues 
(http://support.citrix.com/article/CTX303498). 

SPLM Failed: SPLM Client must be updated to the latest version. 
The SmartPlant License Manager client must be updated to SmartPlant License Manager 
version 11 or later. 

SPLM Failed:  SPLM Server must be updated to the latest version - (server name) 
Indicates you have SmartPlant License Manager 2010 (v11) client installed but are pointing 
to an older version of SmartPlant License Manager licensing machine.  The client version 
requires SmartPlant License Manager 2010 (v11) on the licensing machine. 

SPLM Failed: Unable to read the license file on the server.  try again. - (server name) 
This error appears on the SmartPlant License Manager client machine if the licensing 
machine has been upgraded to version 2008 but has not generated new machine ID and 
has not installed a new version 2008 license key. To resolve the error, generate new 
machine ID and install a version 2008 key.  

SPLM Failed: [Verify Netw Reply] Bad Network Packet; Check SPLM (Cl/Srv) versions 
Indicates a mismatch of SmartPlant License Manager versions.  For example, the client 
machine has a newer version of SmartPlant License Manager installed than the license 
machine does. 

TCPIP mismatch host 192.xxx.x.xxx Key 172.xx.xx.x 
Displays when installing a new license key and indicates the IP address used to generate 
the machine ID does not match the host IP address.  You need to generate the machine ID 
using the new IP address and request a new key. 

The key is invalid and cannot be evaluated. Please enter the correct key. 
This message occurs if you are trying to install a key that is not within a valid installation 
period.  

The license key could not be installed while scavenge is running. Please try again. 
Indicates that you tried to install a license key, and at the same time, a scavenging process 
was running.  Click OK to dismiss the error message.  Try to install the license key after 
the scavenging process ends. 
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The license file on this server is not correct.  Please run Generate machine ID, request a 
new key, and install it 

The SPLM license machine has been upgraded and no new machine ID has been 
generated or a SPLM 2008 key has not been installed.  You will also receive Run-time 
error '53': File not found error.  Click OK to dismiss the error message.  You must 
generate a new machine ID.  Then, request and install a SPLM 2008 key. 

There are no license servers to display for this current user 
This message appears when you click Display License Server for Client - Current User 
Only and there are no defined licensed machines for your use. 

There are no tags in the key on the license machine xxx. 
When running this command, if you have no license key installed or if you have a version 
prior to SmartPlant License Manager 2012 selected, this message displays and a blank 
product tag list also displays. 

There is no key installed on this machine - <servername> 
The license key on your license machine has expired.  You need to request a new license 
key. 

Unable to create file path\filename for machine ID 
This message appears when you run the Machine ID command in the Command Prompt 
window and the path (a folder) does not exist.  To correct the error, create the path (or 
folder) where you want the Machine ID file to be created. 

Unable to read the license file on the server. Try again. 
If you upgrade to SmartPlant License Manager 2010 on your license machine, but you do 
not generate a new machine ID or a SmartPlant License Manager version 2010 license key 
is not installed, this error displays when using the Test Seat Reservation command or 
when using PDS. Generating a new SmartPlant License Manager version 2010 machine ID 
and installing a SmartPlant License Manager version 2010 license key resolves the error. 

[Verify Netw Reply] Bad Network Packet; Check SPLM (Cl/Srv) versions 
This message displays if your SmartPlant License Manager license machine has an older 
version installed than your SmartPlant License Manager client. You need to either upgrade 
your SmartPlant License Manager license machine, or select a SmartPlant License 
Manager license machine that has the same or the latest SmartPlant License Manager 
version installed.  
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A P P E N D I X  G  

Using SmartPlant License Manager Client with UAC On 
If SmartPlant License Manager client machine has UAC turned on and your login belongs to a 
local administrator's group, the following SmartPlant License Manager client options need to be 
elevated local administrator’s right, and you need to run the commands using the Run as 
administrator option.  

  This does not apply to the SmartPlant License Manager options on a SmartPlant 
License Manager license machine.  The SmartPlant License Manager license machine 
automatically elevates to local administrator’s login.  
1. Log onto the SmartPlant License Manager client machine as the local administrator. 
2. To select a license machine for a client, click Start > All Programs > Intergraph 

SmartPlant License Manager.  
3. Right-click SmartPlant License Manager. 
4. Select Run as administrator.  
5. Click Configure and Test > Select License Machine for Client. 
6. Type in your SmartPlant License Manager license machine node name or IP address. 

 
7. Click OK. 

 
 You must use these option as the local administrator. If you did not start SmartPlant 

License Manager using the right-click option and then the Run as administrator option, 
SmartPlant License Manager may return an Access is denied error message.  

 You need to right-click and start the Command Prompt using the Run as administrator 
option if you need to select a license machine using the pdlice –j option.  

8. To stop and remove licensing service (if the SmartPlant License Manager service was 
installed and started), click Start > All Programs > Intergraph SmartPlant License 
Manager. 

9. Right-click SmartPlant License Manager. 
10. Select Run as administrator.  

Appendix H:  SPLM Client on Windows 
7, Windows Server 2008 R2, and 
Windows Vista 
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11. Click Install and Remove > Stop and Remove Licensing Service. 
  You need to be an administrator on the machine to use this option. If you did not 

start SmartPlant License Manager using a right-click and the Run as administrator option, 
SmartPlant License Manager may return the following messages.  Also, the SmartPlant 
License Manager service is not actually stopped and removed in Windows Services: 

 
  You need to right-click and start Command Prompt with Run as administrator option 

if you need to stop and remove licensing service with pdlice –R command.  
12. To install and start the license service (if SmartPlant License Manager service was stopped 

and removed), click Start > All Programs > Intergraph SmartPlant License Manager. 
13. Right-click SmartPlant License Manager. 
14. Select Run as administrator.  
15. Click Install and Remove > Install and Start Licensing Service. 
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  This option needs elevated administrator’s privilege. If you did not start SmartPlant 
License Manager with right-click and Run as administrator option, SmartPlant License 
Manager may return following messages, and SmartPlant License Manager service is not 
actually installed and started in Windows Services (same with pdlice –I command): 

 
  You need to right-click and start Command Prompt with Run as administrator 

option if you need to install and start licensing service using the pdlice –I command. 
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A P P E N D I X  H  

The Administrator can create and schedule a job that automatically installs a new license key.  
This is known as license stacking.  The time of installation for the new license key can be 
defined to install at the time when the current key expires.  The Administrator must create a .bat 
file and schedule the batch file as required.  There is no need to remove the existing key  
For example, you can request a key install date to be July 1 and schedule the batch job to run at 
12:01 A.M. on July 1.  A valid path for the specified output file must exist. 

  If you are using Microsoft Windows 7, Microsoft Windows Server 2008 or Microsoft 
Windows Vista operating system, and you have UAC enabled, you must run this command as 
Administrator. Users can also run this command but they must belong to the local 
administrator's group and have the Run with highest privileges option enabled in the Task 
Scheduler. Or, you can disable the UAC option. 

Creating the .bat file 
Include the following in your .bat file.  In the following example, the key you receive from 
Intergraph replaces mykeyxxxx. 

run cmd 
cd c:\temp\ 
pdlice -a mykeyxxxx >>c:\temp\installog.txt 

Scheduling the .bat file 
1. Select Start > Control Panel. 
2. Double-click Scheduled Tasks. 
3. Double-click Add Scheduled Task. 
4. Use the Scheduled Task Wizard to browse to your .bat file and define when to perform the 

task. 
5. Click Finish. 

 Be sure to check any log files for errors. 
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